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Seuraava lehti ilmestyy maalis-
huhtikuussa 2013. Muistathan 
lähettää lehteen tarkoitetun 
materiaalin ajoissa!
Viimeinen materiaalin-
jättöpäivä on 28.2.2013.,  
mutta materiaalia saa 
mielihyvin lähettää jo ennen 
deadlinea!

KUVAKULMA
julkaisija Rauman KameraSeura ry

Päätoimittaja/taitto
Oili Helenius
Niilontie 10, 
26410 KAARO
p. 040 505 8519
kuvakulmalehti@gmail.com

KUVAKULMA  ilmestyy 2-4 krt vuodessa.
Materiaalin jättö sopimuksen mukaan
Yhdistyksen posti puheenjohtajan osoitteella, 
lehden posti lehden osoitteella 
kuvakulmalehti@gmail.com 
Kilpailukuvat: rkskuvat@gmail.com

KUVAKULMA 3/2012
Kannen kuva: Marko Seppälä

KUVAKULMA -lehden aineistovaatimuksista

Lehdenvalmistusohjelmina käytetään InDe-
sign CS6, Photoshop CS6 ja Adobe Acrobat 
Professional. Kuvankäsittely Photoshop. Ku-
vatiedostot eps, tiff tai jpg-muodossa, reso-
luutio vähintään 240 dpi. 

Otamme vastaan kirjoituksia ja kuvia si-
toumuksetta, mutta emme vastaa sellaisesta 
materiaalista, jota ei ole tilattu. Lähettäessäsi 
kuvia toimitukseen liitä tiedostoon/kuvaan 
kuvaajan nimi ja yhteystiedot. Toimitus ei 
vastaa kuvien säilyttämisestä. Materiaalia 
lehdestä lainattaessa (päätoimittajan luvalla) 
on lähde sekä kirjoittajan nimi mainittava. 
 

Reklamaatiot 7 päivän kuluessa lehden il-
mestymisestä. Lehden vastuu virheistä tai il-
moituksen poisjäämisestä rajoittuu enintään 
ilmoitushinnan palautukseen. 

Valmistamme ilmoituksen tarvittaessa asiak-
kaan ohjeen mukaan. Tekijä laskuttaa erik-
seen suunnittelusta,  ladonnasta, asettelusta 
ja teknisistä kustannuksista. 
Ilmoitushinnat 2013: 
1/1 sivu  4-väri  75 e
1/2 sivu 4-väri  50 e
keskiaukeama 4-väri 120 e

RAUMAN KAMERASEURA RY
Perustettu 3.3.1938
www.raumankameraseura.net

HALLITUS 2012
Puheenjohtaja Marko Seppälä
Kylänpääntie 17
26740 VASARAINEN
puhelin 0400 972 268
e-mail marko.seppala@iki.fi

Sihteeri Marjukka Vähä-Ettala
Puhelin 044 3075 034
e-mail raumanksinfo@gmail.com

Varapuheenjohtaja Oili Helenius
Puhelin 040 5058 519
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Jäsenvastaava Jouni Jalonen
Puhelin 050 5255 878
e-mail jasenrks@gmail.com

Hallituksen jäsen Teemu Laulajainen
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P u h e e n j o h t a j a l t a
M a r k o  S e p p ä l ä

“ Juhlavuoden 
kynnyksellä ,,

Kädessäsi on vuoden viimeinen Kuvakulma, 
toivottavasti löydät lehdestä mielenkiintois-
ta luettavaa. Toimittajamme Anne   Pert-
tula,  Pekka Väkiparta, Teemu Laulajainen 
ja   Timo Vaahtera ovat tarttuneet toimeen  
ja tuottaneet teille monenlaista luettavaa.  
Lehdestä löytyy myös ansiokkaita jäsenten 
toimittamia artikkeleita vaikkapa joulun-
pyhinä tutkittavaksi. Suurkiitokset kaikille 
sisällöntuottajille. 

Joitakin lehteen lähetettyjä  juttuja ja ku-
via on ollut pakko jättää pankkiin käytet-
tävksi myöhemmin, sillä nykyisellä tavalla 
toteutettuna lehteä ei voi enää kasvattaa. 
Myös päätoimittajan ja taittajan aika on ra-
jallinen, niin mukavaa kuin lehden teko on-
kin.  Näitä pankissa olevia juttuja tarvitaan 
aina ja kaikki lähetetyt kuvat ja jutut tulevat 
varmasti aikanaan käytetyiksi. 

Seuramme on saanut syksyn aikana upeita 
kunnianosoituksia kuten ”Vuoden kamera-
seura 2012” -tittelin sekä Länsi-Suomen 
kulttuurimitalin. On hienoa olla osa näin 
menestyksekästä kameraseuraa ja se kannus-
taa yrittämään vielä enemmän ja paremmin 
ensi vuonna. 

Vuosi 2013 on yhdistyksemme juhlavuosi! 
Täytämme  kunnioitettavat 75 vuotta ja se 

asettaa meille erityisiä velvoitteita. Varsinaista 
historiikkiä emme valitettavasti taida saada 
kasaan, jollei joku nyt haluaisi alkaa sellaista 
tekemään? Ilmoittautua voi vaikka allekirjoit-
taneelle. Jos ei tule historiikkiä niin yritetään 
ensi vuoden Kuvakulmissa hieman valottaa 
perinteikkään yhdistyksemme taivalta. 

Ennen seuraavan kuvakulman ilmesty-
mistä on vuorossa yhdistyksen vuosikokous, 
jonne toivon mukaan ilmaantuu vähintään 
yhtä  runsas joukko jäseniä kuin nyt viime 
aikoina ollaan nähty kuukausikokouksissa. 
Tulevassa vuosikokouksessa tullaan käsit-
telemään erittäin tärkeitä ja kauaskantoisia 
asioita. Jos et ole mukana päättämässä niin 
poissaolevana sinun on tyytyminen läsnäol-
leiden päätöksiin. Kokouksessa valitaan myös 
toimihenkilöt tulevalle kaudelle ja toivon-
kin, että juhlavuoden moninaisiin tehtäviin 
ja tapahtumiin  on silloin ilmoittautumassa 
innokas, monipäinen joukko jäsenistöämme! 

Sitä ennen toivotan kuitenkin kaikille 
lukijoillemme oikein Rauhallista ja Hyvää 
Joulua. 

RAUMAN 
KAMERASEURA ry

Tapa htuma ka lenter i 
2012

KUUKAUSIKOKOUKSET 
 
Kokouksissa käsitellään viralliset 
asiat ensin, sitten muu ohjelma. 
Nopeita matkakuvaesittelyjä 
pienellä tarinalla, kuukausikuvien 
rakentavaa ruotimista ja jäsen ja 
tekniikkaesityksiä. Altti Salo esittää 
diaesityksen jonain kuukautena. 
Kuukausikuvaustehtävän aihe 
lainausmerkeissä ko. kuukauden 
nimen perässä. 
 
Maaliskuu:  ”punaista” 
Nils Nyman: kuvaajaesittely
Hans Lehtinen: valaisuvinkkejä
Huhtikuu  :  ”vesi”
Luontokuvaaja Mikko Huunonen 
esittelee kuviaan ja kuvaustaan
Toukokuu :  ”tuli” 
Markku Väänänen: ”mökkielämää”
Kesäkuu    :  Matka Viroon 8.–11.6.
Heinäkuu :  ei kokousta
Elokuu       :  ei kokousta
Syyskuu     :  ”työ”
Valaistuskurssi
Lokakuu    :  ”vihreää”
Marraskuu: Luontokuvailta: 
Ari Ahlfors, Sari Vaaranvuo: 
yksityiskohtien taidetta luonnossa, 
Altti A. Salo
Joulukuu    :  ”maa”
Tammikuu : ”ilma”  
Helmikuu   : vuosikokous 

elmikuun aikaan laadin ensim-
mäistä kirjoitusta, jossa toivoin, 
että kameraseuran jäsenet hou-
kuttelisivat mukaan uusia jäseniä 

ja se on toteutunut enemmän kuin hyvin. 
Seuraavassa numerossa yritin omassa kirjoi-
tuksessani kannustaa jäseniä osallistumaan 
sekä kansalliseen, että kansainväliseen näyt-
telytoimintaan ja kas sekin toteutui. Suomen 
Kameraseurojen Liiton teemanäyttelyyn 
”Työ” valittiin kuvia kaikkiaan 7 eri kuvaa-
jalta meidän seurastamme. Kansainvälisellä 
puolella kuvia meni läpi niin ensimmäiseen 
Saimaan Kameraseuran järjestämään kan-
sainväliseen näyttelyyn, kuin myös neljännen 
Finlandia Circuitin useampaan osanäytte-
lyyn ja nämä siis semmoisia mitä minulla on 
tiedossa. Nyt mietinkin, että minkä toiveen 
haluan seuraavaksi toteutuvan.

ääkiekossa puhutaan usein läpi-
lyöntinsä huipulle tehneen pelaajan 
kohdalla toisen kauden kirouksesta, 
jos peli ei läpimurtokauden jälkeen 

kuljekaan odotetusti. Rauman Kameraseura 
on tavallaan juuri sen toisen kauden kynnyk-
sellä, kun jäseniä ja toimintaa on ollut niin, 
että heikompaa hirvittää. Vaikka lähtökohdat 
ovatkin edellä mainitut, niin en millään voi 

nähdä moisia uhkakuvia seuran yllä, vaan 
päinvastoin. Seurassa vallitseva avoin, ak-
tiivinen ja kannustava ilmapiiri ovat mitä 
mainioin lähtökohta seuran 75v juhlavuo-
teen. Konkreettisen esimerkin seuran hyvästä 
ilmapiiristä sai Rauma Salonin avajaisissa, 
kun seuramme jäsen ja hyvä ystäväni tuli ensi 
kertaa mukaan seuran toimintaan ja koki heti 
olonsa kotoisaksi ja tervetulleeksi, vaikka seu-
rueessa oli monen ikäistä porukkaa. 

uhlavuodeksi on tietenkin jo suun-
niteltu kaikenmoista ohjelmaa ja 
ideoita otetaan vastaan koko ajan. 
Ansaitun Vuoden Kameraseura va-

linnan myötä saatu liiton 1000 euron kou-
lutustuki tietää sitä, että koulutusta pidetään 
toiveiden mukaan myös jatkossa. Liiton tee-
manäyttelyn järjestäminen syksyllä taasen on 
yksi suurimpia ponnistuksia koskaan seuran 
historiassa ja talkoolaisia kaivataan. Kyllä kai 
me myös uusimme paljon kiitosta keränneen 
kuvakävelyn? 

oskus aina mietin ja joskus sitä myös 
kysytään, että mikä vetää mukaan 
kameraseuratoimintaan. En ole ai-
kaisemmin asiaa paljon miettinyt, 

mutta kun samaan kysymykseen jälleen tör-

mäsin, niin pitihän sitä miettiä. Näkisin asian 
niin, että ainakin omalla kohdallani kyse on 
yhteisöllisyydestä. Ennen tuota samaa yhtei-
söllisyyttä koki työyhteisöissä, mutta näinä 
aikoina peli on mennyt sen verran raadol-
liseksi monilla työpaikoilla, ettei samaa yh-
teisöllisyyttä ja samaan hiileen puhaltamista 
enää esiinny. Tästä syystä seuratoiminta on-
kin mitä mukavinta vastapainoa työelämälle, 
kun samasta asiasta kiinnostuneet ihmiset 
kokoontuvat saman asian ympärille viihty-
mään toistensa seurassa.

Marko
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i l p p u r i
TEKSTI JA KUVAT MERJA ELO

Heippa kaikki!

Tämä vuosi on antanut todella paljon minul-
le, empä osanut alkuvuodesta kuvitella mitä 
kaikkea kameraseuraan liittyminen tuo tul-
lessaan. Olen kiitollinen myös Teistä kaikista, 
joita olen tämän vuoden aikana tavannut, 
tietämättänne olette tuuppineet minua eteen-
päin ja olen siitä enemmän kuin tyytyväinen.

Jokaisessa kuukausikokouksessa taisin 
mukana olla, mökillä, kuvausreissuilla ja 
kursseilla tuli käytyä. Tällä hetkellä, kun tä-
tä kirjoittelen, niin olen parhaillaan Oilin 
verkkovalokuvauskurssilla. Kurssi on anta-
nut paljon, uutta on opittu ja uusiin ihmisiin 
tutustuttu. Onneksi kurssia on vielä monta 
viikkoa jäljellä ja olenhan jo varmistanut it-
seni marraskuussa alkavalle muotokuvakurs-
sille, joten ei Oili minusta niin vain eroon 
pääse!

Nyt haluan toivottaa kaikille ihanaa lop-
puvuotta ja oikein Hyvää Joulua!

Marika

Hautausmaalla kummitusta jahtaamassa

Olimme Oilin verkkovalokuvakurssilla kuvaamassa 
Haamuja  Pyhän Kolminaisuuden kirkon raunioilla.

TEKSTI JA KUVA MARIKA PUUMALAINEN

S

Yhtenä elokuun puolivälin lauantaina joukko 
kameraseuralaisia painui maan alle. Kellari-
teatterin uumenissa pääsi nimittäin tutus-
tumaan Lightroom-ohjelman perusteisiin, 
joita Kimmo Turtiainen meille ansiokkaasti 
esitteli.

Paikalla olikin innokasta porukkaa niin 
paljon, ettei varsinaista pulpettipaikkaa 
pöydän ääressä ihan jokaiselle edes riittänyt. 
Mutta se ei toisaalta haitannut mitään, koska 
kaikilla ei ollut omaa läppäriä mukanakaan.

Kimmo kävi koko ohjelman lävitse sys-
temaattisesti kukin ominaisuus kerrallaan. 

Jokaisesta toiminnosta meille kerrottiin esi-
merkkikuvien avulla mitä siinä tapahtuu, ja 
minkälaisia vaihtoehtoja se pitää sisällään.

Kurssi kesti koko päivän. Välillä käytiin 
kaupungilla haukkaamassa lounasta, jonka 
jälkeen jaksettiin uusin voimin loppuilta-
päiväkin.

Osalle kurssilaisista Lightroom oli entuu-
destaan ainoastaan ohjelman mainosten ja 
esittelyiden kautta, toiset olivat sitä vähän ko-
keilleet, ja joku oli jo enemmänkin käyttänyt.

Silti tuntui, että kaikki saivat päivästä it-
selleen ihan mukavasti hyötyä. Niille, joille 

Lightroomin perusteet 18.8.
ohjelma oli aikaisemmin tuntematon, kurssi 
antoi varsin kattavan yleiskäsityksen, ja apua 
siihen arviointiin ja päätöksentekoon hank-
kisiko ohjelman itselleen. Esimerkiksi Aper-
turen ja Lightroomin eroja pystyi nyt vertai-
lemaan. Ne, jotka jo käyttivät Lightroomia, 
saivat monia uusiakin vinkkejä ohjelman 
hyödyntämiseen, ja mieleen palautui toimin-
toja, joiden olemassaoloa ei muistanutkaan.

Merja Elo
Alla kouluttajamme Kimmo Turtiainen opastamassa seuran jäseniä Lightroomin saloihin

18 innokasta seuran jäsentä  kuulemassa Kimmo Turtiaisen esitystä Lightroomista. Kurssille oli todella tilausta ja toiveita uudesta 
kurssista on jo tullut runsaasti. 
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Tässä  jutun kirjoittaja Johanna Jasun oma  tuotos kurssin ajalta. ”kuva tytöstä”

Kauan puhuttu valaisukurssi järjestettiin 
15.–16.9.2012 Rauman kellariteatterin ti-
loissa. Kouluttajana toimi raumalainen am-
mattivalokuvaaja Harri Sirola Studio Ota-
vasta. Kurssille osallistui 15 henkeä. Mukana 
oli niin aloittelijoita kuin jo valaisuasioissa 
osaavia kuvaajia.

Kurssiohjelmaan sisältyi mm. keinovalon 
käyttöä kuvauksessa. Valon käyttäytyminen, 
valon väri, valon muodot ja niihin kuuluvat 
käsitteet kuten päävalo, täytevalo, taustavalo, 
hiusvalo ja korkovalo tulivat tutuiksi kurssin 
aikana. Oppimisvälineinä käytettiin seuran 
omia studiovalaisimia.

Päivän aikana puhuttiin Paramount -va-
laisusta eli yhdellä valolla valaisemisesta, joka 
toimii hyvin hyväihoisella mallilla ja siitä on 
myös ensikertalaisen helppo aloittaa. Lisäksi 
käytiin läpi klassisen Rembrandtin tekemi-

Studiokuvauksen valaisukurssi
TEKSTI JA KUVA JOHANNA JASU

nen. Siinä päävalo tuotetaan isolla tasovalol-
la melko ylhäältä, jotta saadaan kuvattavan 
kasvonmuodot esille, sillä varjon puolelle 
pyritään saamaan kasvoihin rembrandtin 
kolmiona tunnettu valon ja varjon tuotta-
ma muoto. 

Paikalle saatiin myös tämän vuoden Miss 
Rauma Rock -kisan ensimmäinen perintö-
prinsessa, Susanna malliksi, ja Sirola opasti 
feminiini- ja maskuliiniposeeraukset sekä eri 
kuvakulmat.  Bonuksena saatiin myös tietoa 
valotusmittarista, joka takaa onnistuneen 
valotuksen ja nopeuttaa huomattavasti ku-
vaamista.

Valaisukurssilla perehdyttiin teorian lisäksi 
käytännönläheisesti kameroiden ja valojen 
käyttöön. 

Valon muokkainten ja heijastimien käyttö 
sai ainakin muutaman aloittelijan päät pyö-

rälle ja suurta innostusta studiokuvaamiseen. 
Sirola painottikin, ettei salamoiden käytössä 
ole mitään erityistä sääntöä, joten saimme 
itse rakentaa uutta osaamistamme tai sen 
puutetta.  High Key- ja Low Key -kuvausta 
päästiin kokeilemaan, mitä jokainen oli sit-
ten pohtinutkaan  sen oman tehokkaan  45 
minuuttisen kuvausajan tahollaan käyttävän.

Opetus oli mieleenpainuvaa ja suositte-
lenkin lämpimästi kurssin kouluttajaa Har-
ri Sirolaa jatkossa muillekin seuroille, sekä 
oman seuran mahdollisiin koulutuksiin va-
laisuasioissa.

Johanna Jasu

Kuvausretkellä Vanhassa Raumassa
TEKSTI MARIKA PUUMALAINEN, KUVAT TIINA POIMIO JA SARI VAARANVUO

Lauantai aamulla 29.9.2012 kokoontui  
Pyhän Kolminaisuuden kirkon raunioille 
yhdeksän kameraseuralaista + Enska. Ko-
koontuminen oli seuralaisten itse järjestämä, 
tapahtuma sai alkunsa facebookissa Sarin 
ehdottaessa sitä. Sääkin näytti suosivan ja 
innokkaita saapui paikalle, joten ei muuta 
kuin kamerat esille. Enska (Basset hound) 
sai kunnian olla ensimmäinen mallimme, 
malliksi tosin pääsi allekirjoittanutkin ja 
tietty siellä raunioilla oli paljon muutakin 
kuvattavaa.

Jonkin ajan kuluttua ryhmä alkoi hajaan-
tua ja itse liityin seuraan, joka suuntasi Pyhän 
Ristin kirkolle, osan jäädessä vielä raunioille. 
- Hauskaa meillä ainakin oli, pyydettiin ohi-
kulkijoita malleiksemme ja onnistuimmekin 
viimein saamaan ihanan eläkeläisparin kir-
konsillalle poseraamaan! Ikävä kyllä emme 
voi julkaista heistä ottamiamme kuvia, kos-
ka toinen osapuoli ei halunnut heidän kuvia 
nettiin ja toivetta tietenkin kunnioitamme. 
Mutta saimme ainakin kuvatessa tutustua 
uusiin ihmisiin ja samalla rupatella mukavia 
heidän kanssaan. Muuten kuvasimmekin 
toinen toisiamme, milloin edestä ja milloin 
takaa päin (salaa).

Lopuksi ryhmä oli lähestulkoon taas 
kasassa ja saimme kuulla Jounin ja Timon 
salamaharjottelusta. Niitä harjoitteluja he 
olivat kuulemma vielä jatkaneetkin Hanssin 
saavuttua paikalle, meidän naisten lähdettyä 
jo kotiaskareiden pariin. 

Päivä oli kerrassaan ihana, joten toivon 
lisää näitä seuralaisten yhteisiä ja epäviral-
lisia hetkiä! Ihan jokainen voi siis ottaa sen 
ensimmäisen askeleen ja ehdottaa, että kos-
kas taas mennää yhdessä kameroiden kanssa 
jonnekin ja samallahan voi kysellä neuvoja 
kuvamiseen, jos vaan niitä kaipaa.

Kiitos upeasta seurasta

Marika
Mukana olivat: Marika Puumalainen, Sari 

Vaaranvuo, Tiina Poimio, Raimo Iso-Ettala, 
Jouni Jalonen, Timo Haarma, Taru Saukko-
nen, Eija Lahti,  Leena Väinölä  ja Hans Leh-
tinen. Oikean puolen kuvissa ylhäällä Marika 
Puumalainen, alhaalla Raimo Iso-Ettala
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Syksyn kokousten vierailijoita
KUVAT MARKO SEPPÄLÄ JA MARKKU VÄÄNÄNEN

Syyskuun kokouksessamme kävi Tatu Kosonen Kameraseurojen liitosta kertomassa liiton toiminnasta ja sen tarjoamista palveluista 
sekä antamassa arvokkaita neuvoja valokuvauskilpailuihin osallistuville.  Kuva: Marko Seppälä

Lokakuun kokoukseen saimme vieraaksemme niin koti- kuin ulkomaillakin menestyneen ja arvostelun raumalaistaiteilijan Lasse 
Kempaksen.  Kempaksen meriitti-, julkaisu-, näyttely-, palkinto-, apuraha- ja luottamustoimiluettelo on hengästyttävän pitkä.  Taiteilija 
Kempakseen ja hänen tuotantoonsa voit tutustua myös hänen kotisivuillaan osoitteessa www.kempas.fi.. Kuva Markku Väänänen

Luontokuvaillan huumaa koettiin 6.11.
TEKSTI MARJUKKA VÄHÄ-ETTALA, KUVAT ALTTI A. SALO JA ARI AHLFORS 

Ja sitten saapui se minun odottamani luon-
tokuvailta. En ole ennen tilaisuuteen osallis-
tunut, joten avoimin mielin lähdin mukaan 
ja matkaan. 

Altti A. Salo aloitti tilaisuuden teemallaan 
”Raumalt ja muualt – luontokuvia vuosien 
varrelta”. Aloitimme matkamme lepakosta 
mökillä (huikea kuva muuten). Toukkien 
ja liito-oravien kautta matkasimme siirto-
kivilohkareelle. Oli mielenkiintoinen kivi 
muuten – kahden kunnan rajapyykki. Siitä 
reissasimme Narvijärven, Eurajoen ja Rau-
man pohjoisen saariston kautta Poriin, ja 
sieltä Viroon Kihnun saarelle. 

Näimme kuvia kahdesta Unescon perin-
tökohteesta: Vanhasta Raumasta ja Lapin 
Sammallahdenmäestä. Ihmisen jäljistä luon-
nossa – aina se jaksaa yllättää jotenkin, miten 
ihminen toiminnallaan rumentaa luonnon 
kauneutta tieten tahtoen. Altin makrokuvat 
ovat upeita, hienoja värejä ja tarkkoja yksi-
tyiskohtia. Itse olen lumoutunut Altin tavasta 
tallentaa joutsenia. Ne ovat niin kaunista kat-
sottavaa! Yleensä niissä kuvissa on salaperäistä 
usvaa ja käsinkosketeltavaa herkkyyttä. Pel-
kästään joutsenia voisin katsella monta tuntia 
peräjälkeen! Selkämeren myrskykuvat ovat 

Altti A. Salon esityksessä nähtiin muiden luontokuvien ohella mm raumalaisia keväällä 
ihastuttanut ja hauskuttanut harmaahylje, joka polskutteli melkein keskellä kaupunkia.  
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myös vaikuttavia. Myrsky on aina vahvaa 
koettavaa sekä kuvissa että livenä. 

Altilla on oivallinen tilannetaju ja kyky 
nähdä luonnossa sen hienoja vivahteita. Hä-
nen kuvistaan löytyy uskomattomia pieniä 
hauskoja oivalluksia, esimerkiksi yksi naakka 
kirkontornissa kellon ollessa yksi.  Kuvista 
näkyy Altin suhde luontoon. Syvä kunnioitus 
ja arvostus luontoa kohtaan ja pitkänlinjan 
taitajana hän osaa rakentaa kuvansa mielen-
kiintoisella tavalla ja käsitellä taidolla niitä 
juuri sen verran kuin on tarpeellista. Kiitok-
sia Altille uskomattomista kuvista. 

Sitten oli Nils Nymanin eli ”Nissen”  vuo-
ro kertoa Viron Setukaisten matkastamme 
mukavalla ja leppoisalla tavalla. Sessiosta sai 
kattavan kokonaiskäsityksen taatusti, vaik-
kei olisi ollut mukanakaan. Viron reissusta 
on tekeillä kirja ja näimme kokonaisleikka-
uksen kirjaan tulevista kuvista. Jään innolla 
odottamaan kirjaa! Kiitoksia Nisselle kaikista 
Viron reissuista.  Itse olen taas intoa puhkuen 
lähdössä mukaan seuraavallekin matkalle. 

Tilaisuuden viimeinen kolmannes kului 
Ari Ahlforsin kuvia katsellessa. Hän esitti 
kuviaan teemalla ”Elämää porttien sisä-
puolella”. Kuvat olivat Rauman metsäte-
ollisuusalueelta vuosilta 2005 – 2012. Olin 

todella yllättynyt ja vaikuttunut siitä, että 
hän on siellä kuvannut 106 eri lintulajia ja 
että tehdasalueella  pesii noin 55 lintulajia! 
En kyllä olisi ikinä uskonut, että niin paljon 
voi lintuja siellä olla!

Ari oli jaotellut esityksensä vuodenaikojen 
mukaan – talvista luontoa, kesän riemua ja 
syksyistä lintujen muuttoa. Näimme talvis-
ta luontoa ja hurjan tarkkaa havainnointia 
niinkin pieneltä alueelta (en kyllä tarkkaan 
tiedä alueen kokoa, mutta oletan ettei se ole 
ihan hirveän laaja alue sitten kuitenkaan). 
Ihan uskomattoman paljon elämää Ari oli 
löytänyt kyllä siltä alueelta. Loppuhuipen-
nuksena näimme ne harvinaisimmat ja Arille 
merkittävimmät otokset esimerkkinä vaan 
mainittakoon kuningaskalastaja vuodelta 
2011, jonka Ari on bongannut alueella olo-
aikanaan kaksi kertaa. Meitä oli paikalla noin 
60 innokasta kuvien katsojaa. Itse olin kovin 
vaikuttunut näkemästäni ja varmasti kaikki 
muutkin olivat. Kaunis kiitos hienosta elä-
myksestä kuviaan esittäneille valokuvaajille! 

Marjukka
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Edellisen aukeaman alalaidassa Altti A. 
Salon kuvassa pörrää  kirjo-ukonkorento. 
Vasemmalla ylhäällä Ari Ahlforsin 
kuvassa tepastelee kaivonkannen päällä 
pikkutyllin poikanen ja oikeanpuoleisessa 
kuvassa seisoo komea harmaahaikara.  

Keskimmäisessä Altti A. Salon kuvassa 
vasemmalla on kastepisaroita  tuulen 
liikuttamalla hämähäkinseitillä. Kuva on 
kuvattu makro-objektiivilla Mikro-Nikkor 
70-180 mm, 2 sec, f32, iso 100. 

Alimmassa Ari Ahlforsin talvisessa kuvas-
sa vasemmalla kuvaajaa ihmettelevät 
metsäkauriit. 

Tällä sivulla ylimpänä olevassa Ari Ahlfor-
sin kuvassa  maailman menoa tarkkaile-
vatharmaahaikarat. 

Tässä voisi myös kuvaaja lausua muuta-
man sanan kuvasta, kuvaustilanteesta  tai 
kohteesta yleensä. Tuo Altin keskimmäi-
nen kuva varsinkin saattaa jäädä monelle 
epäselväksi. 
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J ä s e n e m m e  e s i t t ä y t y y
Tullaan tutuiksi

”Tullaan tutuksi” -sarjassa esitellään seuramme 
jäseniä sanoin ja kuvin.  Kysymykset ovat kaikille 

samoja ja vastaaja  heittää kysymyssarjan 
seuraavalle, valitsemalleen vastaajalle, jolle laatii 

yhden lisäkysymyksen. Tällä kertaa vastausvuorossa 
yhdistyksen varapuheenjohtaja ja Kuvakulman 

päätoimittaja Oili Helenius

Optiikoissa suosin valovoimaa, 1.4-2.8 on 
kaikkien optiikoitteni suurin aukko.  Pari 
zoomia 28-70 mm ja 80-200 mm, sitten pari 
primeä 85 mm ja 105 mm. Salamalaitteena 
yleensä Nikonin SB800 ja tarvittaessa pa-
ri vanhaa pikkusalamaa lisäksi orjan virkaa 
hoitamassa. Siinä tämänhetkinen kalusto. 
Lisäksi sitten tietenkin studiokalusto ja kai-
kenlaista lisähärpäkettä sekä kuvankäsittely- 
ja muokkausohjelmia on tarttunut  matkan 
varrella mukaan. Eniten kuvaan noilla zoo-
meilla. Viimeisin hankinta on 105 mm:n 
makro-objektiivi, jonka käyttöä ajattelin 
opetella ensi kesänä.  

Mitä kuvaat ja paljonko?
Olen aika kaikkiruokainen, mutta luonto-
kuvaajaksi minua ei kyllä voi luonnehtia - ei 
varsinkaan, jos genreen kuuluu rämpiminen 
metsissä, soilla ja muissa vaikeakulkuisissa 
luontokohteissa. Koirat ovat kai se minun  
omin juttuni. Lisäksi tykkään kuvata ihmis-
tä, niin muotokuvia kuin  tilannekuviakin. 
Lehtitöiden myötä kaikenlainen tilanteiden 
dokumentointi on tullut myös tutuksi.
Kuvaan aivan liian paljon. Viime aikoina 
olenkin yrittänyt keskittyä opettelemaan 
kuvaamaan harkitummin. Toistaiseksi se on 
ollut vain yritystä. 
Digikuvaus on valitettavasti tuonut mu-
kanaan ainakin minulle tavan laukoa ihan 
älyttömiä määriä kuvia. Siinä ei ole mitään 
järkeä ja hermot vaan kärsivät kun koittaa 
valita kolmestakymmenestä lähes identtisestä 
kuvasta sen parhaan...  Puhumattakaan ison 
kuvamäärän vaatimasta tallennustilasta. 

Käsitteletkö kuviasi paljon? 
Joskus käsittelen, joskus en - yleensä kyllä ai-
nakin jonkun verran. Nk ”perussäädöt” teen 
varmaan joka kuvaan paitsi facebookissa ja 
sen tyyppisissä medioissa esitettävät kuvat. 
Sinne saatan heittää kuvia ihan suoraan ka-
merasta - se riippuu vähän kuvien käyttötar-
koituksesta ja  tilanteesta. Nyt esimerkiksi 
kun minulla on ollut koiranpentuja, joista 
ihmiset haluavat nähdä kuvia en niitä käsitte-
le yleensä ollenkaan,  sillä ei yleisö katso niitä 
kuvia valokuvauksellisten ansioiden vuoksi 
vaan niiden kuvauskohteiden itsensä vuoksi. 

Onko sinulla esikuvia?
Ei ole ketään sellaista, jota ihailisin yli kaiken 
tai pyrkisin itse tuottamaan samantapaista 
jälkeä.  Toki maailmassa on monia kuvaajia, 
joiden kuvat ovat mielestäni todella hienoja, 
mutta mikään yksittäinen tyylisuunta tai ku-
vaajan tuotanto ei oikeastaan ole mielestäni 
toista parempi vaan minunkin  makuni on 

muuttunut vuosien saatossa. 

Mukavimmat muistosi 
valokuvauksen parissa?
Otavan ”Koiranvirkoja” -kirjan kuvaukset, 
joiden vuoksi matkustin ympäri maata ku-
vaamassa kirjan päähenkilöitä. Näistä mat-
koista ja kuvattavista jäi paljon mukavia 
muistoja. 

Onko kuviasi ollut esillä ja jos, 
niin missä?
Koirakirjoissa ja -lehdissä pääasiassa, myös 
joissakin näyttelyissä ja pari kertaa olen 
osallistunut kilpailuihinkin. Omia näytte-
lyitä olen pitänyt muutaman.  Ehkäpä sitten 
eläkkeellä on paremmin aikaa sen tyyppiseen  
toimintaan.

Millaisia terveisiä haluaisit lähet-
tää muille jäsenille?
Älä ota kritiikkiä  liian vakavasti. Kaikki 
neuvot ja mielipiteet kannattaa kuunnella 
ja ottaa mahdollisesti opiksi.  Mutta jos ku-
vasi miellyttää sinua  itseäsi niin silloin se 
on hyvä. 

Miksi juuri valokuvaus?
Isäni harrasti valokuvausta ja totuin lapses-
ta saakka siihen, että kuvia otettiin aina ja 
kaikkialla. Kun sitten sain oman kameran 
niin innostus tietenkin siitä vain kasvoi. Oli 
hienoa huomata voivansa tallentaa hetken 
juuri sellaisena kuin se oli kuvaushetkellä.  
Visuaalisuus on ollut minulle tärkeää  lapses-
ta lähtien, mutta en  ole sillä tavalla lahjakas, 
että osaisin  piirtää  tai maalata. Valokuvauk-
sessa näitä taitoja ei tarvita - ehkäpä se siksi 
tuntuu omalta tavalta ilmaista itseään. 

Seuraavaksi heitän kysymykset Turtiaisen 
Kimmolle ja lisäkysymykseni hänelle on: 

Onko elämää ilman 
Photoshoppia? 

Kuka olet?
Heleniuksen Oili Kaaron puskista

Mistä tulet?
Tulin Raumalle 25 vuotta sitten Turusta ja 
hyvin olen viihtynyt. 

Mitä teet työksesi?
Varsinaisen toimeentuloni hankin vakuu-

tusalalla yhteyspäällikkönä, mutta sen lisäksi 
työskentelen aikuiskasvatuksen puolella sivu-
toimisena opettajana ja teen lähinnä harras-
tuksena  sivuntaittohomia ja valokuvausta. 

Onko sinulla muita harrastuksia 
valokuvauksen lisäksi?
Koirat ovat olleet harrastuksenani lapsesta 

saakka. Ensimmäinen rotuni oli saksanpai-
menkoira ja 1980-luvun loppupuolella mu-
kaan tulivat länsigöötanmaanpystykorvat, 
jotka nyt ovatkin ainoa rotuni. Kasvatan 
myös pienimuotoisesti.  Myös tietotekniik-
ka kiinnostaa, mutta lähinnä kaiken uuden 
kokeilemisen muodossa.

Milloin kiinnostuit 
valokuvauksesta?

Ensimmäisen kamerani sain noin kymmen-
vuotiaana - sellaisen coca-colakameran, jollai-
sella moni muukin ikätoverini on aloittanut 
valokuvausharrastustaan. Ensimmäinen jär-
jestelmäkamera tuli kuvioihin muistaakse-
ni rippilahjana. Sen myötä sitten tutustuin 
mustavalkokuvien vedostamiseen ja koi-
raharrastukseni myötä ajauduin tekemään 
saksanpaimenoiraliiton jäsenlehteä, johon 
tietenkin tarvittiin paljon kuvia. Näin ku-
vauskohteikseni valokoituivat koirat jo hyvin 
varhaisessa vaiheessa.

Milloin löysit Rauman 
Kameraseuran?
Muutettuani Raumalle se oli muistakseni ku-
vakaupan Jari, joka vihjaisi minulle Rauman 
Kameraseurasta. Soitto silloiselle puheenjoh-
tajalle Markku Väänäselle  ja sitten mukaan 
kk-kokoukseen. Siitä se lähti. 

Mikä on parasta 
kameraseuratoiminnassa?
Vaikka valokuvausharrastuksessakin kilpail-
laan ei kameraseuratoiminta ole ollenkaan 
niin kilpailupainotteista harrastamista kuin  
esimerkiksi koiraharrastus. Olen elämässä-
ni kilpaillut koirien kanssa niin paljon, että 
nautin suuresti kun voin vain harrastaa ku-
vaamista saman henkisten ihmisten kanssa. 

Mitä parannettavaa näet seuran 
toiminnassa?
Seuran jäsenmäärä on kasvanut räjähdyk-
senomaisesti ja sen myötä myös harrastus-
muodot monipuolistuneet valtavasti. Tällä 
hetkellä mielestäni suurin ongelma on pieni 
tekijäjoukko. Jotenkin seuraan pitäisi saada 
istutettua tekemisten kulttuuri. Jokainen jä-
sen voi tehdä muutakin (ja saa samalla pal-
jon iloa itselleen) kuin vain tulla ”valmiiseen 
pöytään”. Ahkeria tekijöitä on toki vuoden 
aikana ilmoittautunut, mutta lisää tarvitaan 
jos halutaan säilyttää monipuolinen tarjonta. 
Jokainen jäsen voi myös järjestää toimintaa 
ja siitä on jo ilokseni monia esimerkkejä ole-
massakin.

Millaisella kalustolla kuvaat? 
Nikon on ollut minun merkkini alusta alka-
en. Joku pieni syrjähyppy Sonyyn tapahtui 
jossain välissä, mutta sitten palasin ruotuun 
nopeassa tahdissa. Laukussa keikkuu kaksi  
Nikonin runkoa, D3s nopeiden tilanteiden 
tallentamiseen ja D800 uusimpana hankin-
tana lähinnä studiokäyttöön ja matkalla mu-
kana pidettäväksi. 
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Arvoisa vastaanottaja, 

 

 

Tervetuloa  4th Finlandia Circuitin 1st Rauma Salon avajaisiin 

Cafe Saliin lauantaina 3.11.2012 klo 15. 

( Cafe Sali, Kuninkaankatu 22, 26100  RAUMA) 

 

 

OHJELMA 

Näyttelyn avaus: Pj Marko Seppälä avaa näyttelyn 

Tutustuminen valokuvataiteeseen  

Pientä purtavaa 

Musiikillisesta tunnelmasta vastaa Tuija Nyrhinen 

 

Valokuvakilpailu Finlandia Circuit 2012 näyttäytyy ensimmäistä kertaa Raumalla, neljännen kerran 

Suomessa ja on maailmanlaajuinen FIAP  

(Federation Internationale de i’Art Photographque) tasoinen valokuvakilpailu.  

Näytteillä otoksia valokuvien parhaimmistosta maapallon joka osasta. 

 

Kuvagalleria osoitteessa: 

http://photo.finlandcircuit.fi/PhotoportalQA/gallery/GetByPartExhibition?partExhibitionId=35&seri

es=33 

 

 

Näyttelyn järjestävät:  Suomen Kameraseurojen liitto, Vantaan Fotokerho, Rauman Kameraseura, 

Mielikuvitus ry, Saimaan Kameraseura sekä Kameraseura Mielikuva ry. 

 

Olet lämpimästi tervetullut !! 

Terveisin Rauman Kameraseura 

 

Ilmoitathan tulostasi viim. 31.10.2012 mennessä 

 Markolle, 0400-972268 tai marko.seppala@iki.fi tai 

Marjukalle, 044-3075034, raumanksinfo@gmail.com 

 
 

 

Raumalla tuomarointiin osallistui Oili He-
lenius ja Minna Paananen, sekä allekirjoit-
tanut. Oili sai tuomaritehtävän yllättäen ja 
päivän myöhässä kuvakavalkadin ollessa jo 
muiden käytettävissä. Usean päivän kuvien 
tuijottelu ja herpaantumaton keskittyminen 
vaati välillä kävelylenkkeilyä ja kahvikupillisia 
toinen toisensa jälkeen. Pimennetty huone, 
vaatimuksena myös kalibroitu näyttöruutu, 
sekä mielellään myös iso näyttö, koska pieni 
näyttö rasittaisi silmiä ja kuva voitaisiin suu-
rentaa isommaksi arviointia helpottamaan. 
Kuvien arvostelussa käytettiin 1-5 arvostelus-
kaalaa. Jokainen tuomari antoi omat kuva-
kohtaiset pisteet. Kaikkien kolmen tuomarin 
pisteet summattiin ja tämän perusteella kuva 
päätyi näyttelyyn hyväksytyksi tahi ei. 

Pistemäärän raja-arvot, millä kuvat pääsi 
mukaan näyttelyyn määräytyi lopullisessa 
kaikkien kolmen tuomarin yhteispalaverissa. 
Tavoitteena oli noin 20-25%:n hyväksyntä 
kokonaiskuvamäärästä. Kisassa on kolme 
erillistä sarjaa musta-valkoiset-, värilliset- 
ja matkakuvat. Varsinkin musta-valko- ja 
matkakuvien osalta pitää tutustua kuvaa 
koskeviin sääntöihin huolella, kun lähettää 
kuviaan FIAP ja PSA hallinnoimiin kisoi-
hin. Matkakuvissa kuvankäsittely minimissä, 

ei creative-kuvia, ei poseeraavaa kasvo- tai  
puolivartalokuvaa, ei elementtejä muutettu 
eikä lisätty, vain lievät perussäädöt sallittuja. 
Musta-valkokuvissa vain musta-valkoinen 
kokonaisuus tai yksi toonattu värisävytys 
koko kuvaan on hyväksyttävää.   

Noviisina ensimmäisen kansainvälisen 
valokuvakisan tuomaroinnin ensi-innostus 
haihtui varsin nopeasti, kun kokonaiskuva-
määrä selvisi ja kuvat alkoivat soljua ruudulle. 
Kuvien arvostelussa ei näkynyt tekijää eikä 
kuvan nimeä. Kuvat eivät olleet myöskään 
kuvaajajärjestyksessä, vaan saman kuvaajan 
kuvat saattoi olla ensimmäisenä ja jopa vi-
hon viimeisenä. Oma pistearvio piti myös 
antaa kohtuullisessa ajassa, sekä päättää, 
josko kuvan ominaisuudet yltäisi vaikkapa 
palkintosijoille saakka. Rauman tuomarit te-
kivät lopullisen arvion yhteispalaverissa, jossa 
pohdittiin ja valittiin palkintokuvat, ilman 
henkilötietoja tai kuvan nimeä. 

Oma kansainvälisten kisakuvien seuraa-
minen on ollut kuitenkin jonkin verran 
aktiivista. Eri kansainvälisten kisojen kuvia 
voi tutkailla myös avoimessa netissä kisojen 
järjestäjien sivuilla. Joten aivan niin suurena 
yllätyksenä upeiden kuvien katselu omalla 
ruudulla ei kuitenkaan tullut. Maailman 

61:stä maasta tulleet kuvat ovat jo sinällään 
eksoottista seurattavaa. Elämänmenoa, kult-
tuuria, luontoa, maisemia, ihmisiä, eläimiä 
ja kaupunkien sykettä. Piipputupakan ja 
auringon polttamia kurttukasvoja, sensu-
elleja nudekuvia, ihmiskohtaloita, työn ja 
toimeentulon uuvuttamia kansanmiehiä ja 
naisia, liikunnan ja leikin riemua, tanssin ja 
luonnon plastista kauneutta. Kuvaajien taito 
ja antautuminen kohteen valintaan, osaavaan 
ajan ja paikan rytmiin sijoittuminen osoittaa 
omaperäistä otetta ja keskittymistä. 

Ehkei kauneus olekaan ainoastaan katsojan 
silmissä taitaa se olla myös kuvaajan silmässä. 
Kaikkiaan hieno kokoelma lähetettyjä kuvia, 
mutta valitettavasti lukematon määrä hyviä 
kuvia jäi näyttelyn ulkopuolelle.

Tuomarina olo tämänkaltaisessa kansain-
välisessä valokuvakisassa oli ikimuistoinen 
ja kokemuksena vertaansa vailla. Siitä kiitos 
Rauman Kameraseuralle uskaltautuessaan 
ottaa näinkin suuri haaste vastaan ja antaa 
tuomarivastuuta ensikertalaisille Oilille, 
Minnalle ja minulle. Kaikki kolme selviy-
tyivät urakasta kunnialla. Erityiskiitos Oilille 
ja Minnalle omien päivätöiden ohessa suori-
tetusta arvostelutyöstä. 

Jorma Jokisalo  

Rauman Kameraseura osallistui yhtenä järjestäjänä Suomen 

kameraseurojen liiton kansainväliseen valokuvakilpailuun. 

Kiertonäyttelyn eli Circuit’in muut järjestävät paikkakunnat olivat 

Vantaa, Lempäälä, Joutseno ja Ylöjärvi. Valokuvat jyrytettiin kaikilla 

viidellä näyttelypaikkakunnalla kolmen tuomarin voimin, joista 

kukin suoritti kuvakohtaisen pisteytyksen yksityisesti omalta 

tietokoneeltaan omaan päivärytmiinsä sovittaen.  Koska kisaan 

lähetettiin yli 6700 digitaalista valokuvaa tuomareiden vapaa-ajan 

käytölle tuli kerralla useiksi päiviksi täysin uusi merkitys ja tavoite. 

4. Finl and  Inter n ati o n al  D ig ital  C irc uit  ja  1.  R aum a  S alo n

Neljännen Finland Circuitin yksi tuoma-
rointiseura oli nyt ensimmäistä kertaa Rau-
malta. Minna Paananen, Jorma Jokisalo ja 
Oili Helenius pisteyttivät 
seitsemisen tuhatta kuvaa, 
jotka oli lähetetty ympäri 
maailmaa ja jakoivat par-
haimmille palkintoja. Koko 
Circuitin paras kuvaaja tuli 
Taiwanista: Tsun-Hsiung Chi-
an. Hän sai eniten hyväksymisiä 
kuvillaan.

Näyttelyn avajaiset pidet-
tiin Cafe Salissa pyhäinpäivänä 
3.11.12. klo 15 alkaen. Tarjoilut 
maksoi Suomen Kameraseurojen 
Liitto, Rauman Kameraseura sai 
tuomaroinnistaan 500 euroa puh-
dasta käyttörahaa,

Avajaiset pääsivät alkuun, kun 
tekniikkaryhmä sai johdon tietoko-
neen ja taulutelevision väliin. Siihen 
meni parikymmentä minuuttia. Kaikki kol-
mekymmentä ilmoittautunutta odottivat 
kärsivällisesti. Viihdepuolesta vastasi myös 
Amusia -yhtyeestä tunnettu Tuija Nyrhinen 

pianolla ja laulullaan. Marko Seppälä avasi 
avajaiset lyhy- ellä informoivalla 

puheellaan. Lyhyes-
tä virsi kaunis, niin 
kuin sanotaan. 
Markolla oli tie-
tysti kiire nostella 
- maljaa. Se teh-
tiinkin hillitysti. 
Vihdoin koitti 
odotettu hetki, 
kun saimme 
nauttia visuaa-
lisista alkupa-
loista: Kilpai-
lun parhaat 
antoivat 
vartin dia-
esityksen, 
jollaista 

ei ihan joka päivä näe. 
Mahtavia maisemia, huumoria, vauhtia ja 
väriä sekä pelkistettyä inhimillisyyttä. Kom-
menteista muistan ihastuneet huokaukset ja 
järkevät toteamukset siitä, mitkä tekijät ovat 
vaikuttavan kuvan rakennusaineita. Lapset, 

VALOKUVIN
Maailman ympäri kolmessa päivässä

heidän silmänsä, jylhiä maisemia aamusu-
mussa, jyrkkäkontrastiset kuvat vanhuksista, 
kallion, talojen, pilvien muotoja, itämaisia 
kalastajakyliä, eksoottisia eläimiä, kulttuure-
ja, urheilupysäytyksiä. Kuvat olivatkin nan-
naa silmille ja jonkin verran niiden taaksekin.

Äkkiä jonkun vatsa kysyi milloin saadaan 
ruokaa. Järjestelijänä ja lähettinä minä alle-
kirjoittanut vastasin että varmaan aika pian. 
Kävin varmistamassa henkilökunnalta an-
tipaston riittävyyden ja ohjasin vieraat ha-
kemaan ohjeella: kaksi per naama. Unohtui 
vain mainita, että se 2/lärväke koski jokaista 
viittä lajia. Loppuja sai sitten viedä kotiinsa-
kin. Kiitos SKsL:lle illan täydestä vatsasta. Ja 
Salille sen toteuttamisesta.

Yhteenvetona voisi todeta, että tapahtuma 
sai ansaittua kunniaa ihmisten pukeutumi-
sesta päätellen, Rauman Kameraseura oli 
hienosti edustettuna Cafe Salissa. Se myös 
kiinnitti huomiota muissa asiakkaissa. Olisi 
melkein pitänyt laittaa kyltti, kuka juhlii ja 
mitä juhlii. Seuramme alkaa näkyä! Siitä iso 
kiitos aktiivisille seuralaisille.

Teemu Laulajainen

Circuit-näyttelyn avajaiset pidettiin Cafe Salissa pyhäinpäivänä 3.11.12.

Circuit-näyttelyn avajaistunnelmia ja yleisöä. Oikealla yljäällä avajaisten esiintyjä Tuija Nyrhinen, vasemmalla alhaalla seuran pu-
heenjohtaja Marko Seppälä lausumassa näyttelyn avajaissanoja. 
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Averil Tame Gabon EFIPA., FAPS Tasmanian Tulis AFCC GOLD

Hendro Hioe Indonesia Preikestolen FIAP GOLD

Nils-Erik Jerlemar Sweden UPI CR4, ERIAP/p, MPSA, ARPS
Man in Window No2, AFCC  SILVER

Alexander Hochhaus Germany AFIAP Lady in black
Rauma AFCC Gold, Best poople photo

Tsun-Hsiumg Chian Taiwan Mountaineering party 
PSA GOLD

Sue Slater Australia  I am so Thirsty AFCC GOLD Ming-Hui Cheng Taiwan  Farm  life 1  UPI GOLD
Margaret Coull United Kingdom, AFIAP, DPAGB, ARPS
Across the snow  AFCC GOLD

Yuriy Zilinskyy Ukraine PSA 
EID*; NSPAU  Offensively 
PSA GOLD

Ilario Ledda Italy Le rondini 2
FIAP GOLD

Yau Ming Charles HO Hong Kong ERIAP; FPSHK; FCPA 
Water Dance UPI GOLD Yu Pei Huang Taiwan, Village life, PSA GOLD

Jorn Andreas Lovland, Norway 
Mountainhorse FIAP GOLD

Joseph Tam Australia Life is beautuful UPI GOLD

4. Finland           

International    

Digital Circuit 

ja 1 . Rauma Salon       

MITALISATOA
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Köln on varsin merkittävä messukaupunki 
ja messualue sen mukainen. Kahden ison 
hallialueen välillä on ulkoalue, jossa messu-
jen aikana on erilaisia tapahtumia ja jossa 
voi istuskella lepuutellen jalkoja, messujen 
kiertäminen kun on tunnetusti raskasta puu-
haa. Hallit jakaantuivat neljään kategoriaan: 
kuluttajille ja ammattilaisille tarkoitettuihin 
valokuvaukseen liittyviin laitteisiin, kulutta-
jille ja ammattilaisille tarkoitettuihin tulos-
tukseen ja kuvatuotteisiin liittyviin asioihin, 
studiolaitteisiin ja kuva-alan yrityksille suun-
nattuihin tuotteisiin kuten suurkuvatulosti-
met, valokuvakioskit jne. 

Suuria ja pieniä osastoja

Jättimäiset osastot olivat luonnollisesti Cano-
nilla ja Nikonilla, mutta myös Sony, Pana-
sonic, Fuji ja - ehkä yllättäen - Samsungkin 
olivat panostaneet messuihin paljon. Digi-
pokkarien vyöry ja järjestelmäkameroiden 
kohtuulliset hinnat ovat selkeästi muuttanut 
messujen luonnetta ja samalla lisännyt ”taval-
lisen kansan” kiinnostusta valokuvaukseen ja 
laitteisiin.  Merkittävää oli aasialaisten runsas 
osallistuminen monilla pienillä ja messuihin 

suhteutettuna keskikokoisilla osastoilla tarjo-
ten lähinnä kaikenlaista lisälaitetta mitä vain 
voi kuvitella ja vielä enemmänkin.

Kaikki kameravalmistajat pyrkivät tuo-
maan jotakin uutta Photokinaan. Canon 
esitteli EOS 60D:n, 18 megapikselin APS-
C -koon järjestelmäkameran. Toinen uutuus 
on Canon EOS 6D, täysikokoisella kennolla 
20,2 megapikseliä. Erityisen merkittäväksi 
jälkimmäisen tekee se, että se on ensimmäi-
nen järjestelmäkamera, jossa on sisäänra-
kennettuna sekä GPS että WI-FI. Voisipa 
sanoa, että vihdoinkin. Tuon hinataluokan 
kameroissa sen ei luulisi olevan ainakaan kus-
tannusongelma, sillä jopa pikkupokkareissa 
nuo ominaisuudet ovat yleistyneet. Canonin 
uutuuksissa oli tavallaan yksi mullistavakin 
julkistus: EF 8-15 mm, joka on ensimmäinen 
kalansilmäinen zoom-objektiivi, joka muun-
tautuu täyden koon kalansilmästä täysin pyö-
reään 180 asteen kuvaan.

Nikon esitteli täyden kennon D600 järjes-
telmäkameran, joka sijoittuu katukaupassa 
alla kahden tuhannen euron hintaluokkaan. 
Valistunut arvaus on, että Nikon on pikku 
hiljaa siirtymässä pois APS-C -koon kennos-
ta. Vielä vahvemmin esillä oli peilittömien 

järjestelmäkameroiden N1-malliston uutuus 
J2. Kyseessä on lähinnä päivitys J1-mallista 
uusilla objektiiveilla, yksinkertaisemmal-
la käyttöliittymällä ja pienemmällä koolla. 
Kompaktikameroiden puolella Coolpix 
P7700 on jo useissa testeissä todettu luo-
kassaan parhaaksi käytettävyytensä ja moni-
puolisuutensa ansiosta kuvan laatua unoh-
tamatta.

Eizo esitteli kaksi uutta huippumonitoria, 
joista huippumalli jopa kalibroi itse itsensä. 
harmillisena puolena on hinta, joka mallista 
riippuen vaihtelee kahdentuhannen ja kol-
men ja puolen tuhannen välillä.

Muita merkkejä väheksymättä jokaisel-
ta valmistajalta oli tarjolla uutta, joskaan 
palstatila ei anna myöten kaikkien erikseen 
mainitsemista.

Selviä trendejä näkyvissä

Ensi kertaa messuilla oli esillä myös pu-
helimia. Muutamia puhelimen ja kame-
ran ”ristisiitoksia” oli jo näkyvissä ja lisää 
on varmasti tulossa. Tekniikan kehittyes-
sä laadukkaat kamerakomponentit pie-
nenevät entisestään. Tästä oli osoituksena 
myös todella pienten aktiivikameroiden 

Photokina on joka toinen vuosi Kölnissä järjestetty valokuvausalan 

messutapahtuma ja lajissaan maailman suurin. Tänä vuonna 

kävijöitä oli yli 180.000. Jotakin tapahtuman laajuudesta kertoo 

sekin, että ensimmäisenä päivänä kahdeksan tuntia kierrettyäni olin 

nähnyt halleista ja messuista noin kolmanneksen. 

lisääntyminen still- ja videokuvaukses-
sa. Video on myös tullut järjestelmka-
meroihin jäädäkseen. Vaikka vielä ei 
käytännön tasolla päästä huippuluokan 
ammattilaatuun, niin järjestelmäkameroi-
den videolisälaitteita oli esillä aina huvit-
tavuuteen asti. Valokuvausharrastuksen 
lisääntyminen on vaikuttanut myös lauk-
kuvalmistajiin. Uusia laadukkaita kamare-

alaukkumerkkejä on valikoimasa useita.

Kiinnostus virtuaaliseen panoraamakuva-
ukseen on lisääntynyt ja edelleen lisäänty-
mässä. Tärkeimpänä syynä on ohjelmistojen 
kehittyminen helpompaan suuntaan ja tarvit-
tavien lisällaitteiden parempi saatavuus. Itse 
olin esittelemässä asiaa osan aikaa IVRPA:n 
osastolla, joka on kansainvälinen virtuaali-
kuvaajien yhteenliittymä. Osasto oli varsin 

suosittu ja varsinkin päivittäiset esitelmät 
kiinnostivat messukansaa.

Studiovalaisimia oli esillä runsaasti - ei to-
sin mitään täysin uutta. Led-valaisimia olisi 
odottanut olevan esillä enemmänkin, mutta 
ilmeisesti riittävän tehokkaiden ledien val-
mistamisessa on vielä ongelmia. Pieniä valai-
simia oli jonkin verran, mutta luonnollisesti 
niiden teho rajoittaa käyttöä. Parhaat käyttö-

 IVRPA:n osasto Photokinassa (International  VR Photography Association)

Iso mies vielä isommassa koossa
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alueet tällä hetkellä lienevät makrokuvaus ja 
lähimuotokuvaus. Suurkoon filimikameroita 
oli esillä muutamia, mutta ne tulevat selvästi 
jäämään pienen piirin huippuammattilaisten 
kalustoksi.

Kuvasta mitä vain

Digihuumassa saivat paperikuvat väistyä 
ja koneen kovalevyt täyttyivät ja täyttyvät 
varmaan vieläkin kuvilla. Ympyrä on kui-
tenkin sulkeutumassa ja palaamme jälleen 
paperikuviin, nyt tosin suoraan kuvakirja-
muodossa. Kuvavalmistajia oli esillä todella 
runsaasti ja kuvatuotteita laidasta laitaan. 
Tarjolla on kaikkea, mihin vain kuvan saa 
liitettyä: mukeja, tyynyjä, verhoja, avaimen-
periä, rintanappeja‚ 70-lukukin palaa takaisin 
kuvatapettien muodossa.

Kolor Software on maailman johtavia panoraama- ja virtual tour -ohjelmien tekijöitä. Esilä olivat uudet versiot Autopano-  ja Panotour-ohjel-
mista.

Canonin, Nikonin ja Sigman osastoilla pääsi testaamaan pitkiäputkia.

Näkemisen ja kokemisen lisäksi messu-
jen hyvänä puolena oli, että esittelijät saivat 
myydä tuotteitaan vasta messujen viimeise-
nä päivänä eli sunnuntaina, jolloin olin jo 
kotimaassa. Jäivät siten harkitsemattomat 
heräteostokset tekemättä.

Kimmo Turtiainen

L I N K K E J Ä

Minikameroita
www.jobo.com
www.rollei.com
http://www.iontheaction.com/

1 2 3
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P I K K U K U V A T

1. Sigma 200-500mm f 2.8 ja telejatkeella 
400-1000mm f. 5.6. Onko vapaaehtoisia 
kantajia.

2-4.  Kuvakokeiluita varten olivat näytteil-
leasettajat keksineet (mielenkiintoisia?) 
testikohteita.

5. Esillä oli jonkin verran myös raskaan 
sarjan kalustoa.

6. Kustomoidulla ohjaimella ohjattiin 
Olympiakisoissa useita etukäteen asen-
nettuja Nikon D4 kameroita.

7. Kuvasta tehtävien tuotteiden valikoima 
rikkoo jo mielikuvituksenkin rajat.

8. Raskasta sarjaa. Arca Swiss on ehkä 
tunnetumpi kiinnikesysteemistään, mutta 
sen suuret filmikamerat hengittävät vielä.

9. Kuvakauppiaille ja kuvavalmistamoille 
oli omat herkkunsa tulostimista kuvakios-
keihin.

10. Zeiss esitteli mm. 1.4 valovoiman 55 
mm:n objektiivia Nikonille ja Canonille.

11. Valokuvia voi käyttää näinkin.

12. Järjestelmäkameroiden videolisä-
laitteet saavat jopa hiukan huvittavia 
piirteitä.

13. Nikon oli panostanut kaiken muun 
ohella rajusti Nikon V1 peilittömään 
järjestelmäkameraan. Haukkaat saivat 
kuvauttaa itsensä ja tulostaa kuvat 
mukaan.

14. Ajoittain väkeä oli niin runsaasti, että 
jopa liikkuminen oli hankalaa tuotteisiin 
tutustumisesta puhumattakaan. Kuvassa 
Nikonin osastoa.

3D Photostudio - studiosimulaatio-oh-
jelma
www.elixxier.com
Laadukasta pikkutavaraa
www.hahnel.ie
Varustelaukkuja
www.plaber.com
www.peli.com
www.boblbee.com
www.golla.com
Huippuluokan monitorit
www.eizo.fi
Led-valaisimia
www.metz.de/en/
Kuvauskoptereita
www.height-tech.com
www.globe-flight.de
www.asctec.de
Kiinnitystavaraa.com

www.novoflex.com
www.sunwayfoto.com/html/index2.html
www.moonslide.de/
virtuaalikuvaukseen
www.orbitvu.com
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Ilmasto lämpenee, se on kylmä tosiasia, 

kuten joku on oivasti kiteyttänyt. 

Miten käy talvien Suomen Lounaisessa 

saaristossa, entä Raumanmerellä?

TEKSTI JA KUVAT RAIMO SUNDELIN

Talvella 1972 luontoinnostus vei 
minut ensikertaa kevätjäille saaris-
toon kun linnut tulivat. Siitä läh-
tien kevättalvien pyöräily aamupi-

meässä vongahtelevilla ja railojen rikkomilla 
silojäillä ilman nastoja on ollut tasapaino- ja 
tekniikkalaji, joka on lähes korvannut muun 
urheilun tarpeeni. Jalkratas lumisella jäällä on 
pitänyt huolen jalkalihaksistosta ja hapen-
ottokyvystä. Sukset, luistimet ja lämpövuo-
risaappaat ovat olleet muina kulkuvälineinä 
kotisaaristossa 40 -vuotta. Talven hiljaisuutta 
en ole polttomoottoreilla rikkonut.

Talvi alkaa vuoden vaikuttavimmalla 
maisemamuutoksella, saaristokuvaajan 
täyttymyksellä. Luodot saavat valkeat 
lakanat, joita syysmusta meri tuulella 
reunoilta nyhtää. Yhden mieleenpainu-
vimmista saaristopäivistä koskaan vietin 
20.11.1977 kun ensikerran varta vasten 
lähdin Syvärauman rannasta kuvaamaan 
ensilunta merelle. Kylmän-Santakarin 
laella 1857 rakennetun luotsituvan rau-
nioilla jäi merimaisema lähtemättömästi 

mieleen. Sen haalenemista olen estänyt 
toistolla. Saman kohteen ensilumilla olin 
1996. Tuolloin vinhaan kiitävät pilvirie-
vut raeryöppyineen ja valosuihkuineen 
kruunasi tuulessa hoippuva merikotka 
ja etelään toitottaen matkaava laulujout-
senparvi kun venetalaan leessä kuvaus-
session päätteeksi kahvittelin. Vielä 2010 
onnistuin kertovilla valoilla ja riittävillä 
pixeleillä tallentamaan luotsituvan lumi-
set jäänteet taustanaan merimaisema ja 
Kylmäpihlajan majakka.

Lähes kolmetkymmenet ensilumet 
olen Rauman saaristossa valokuvannut. 
Joinain syksyinä rantajäät vankistuivat 
ennen lumen tuloa, eikä pienpaatilla 
ensilumen saaristoon päässyt.  Kolmesti 
lumi on satanut ruskaan vuoden 1972 
jälkeen. Vuoden 1997 YK:n päivän 
Santkarin pookin punaisten lumisade-
pilvien kuvaani kysytään edelleen niin 
kuin Petäjästen siltaakin, kuvattuna 
6.12.1975. Viimeisimmän lumirus-
kan koin nyt 27.10.2012 kun merelle 

RAUMANMERI JÄÄTYY
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lähtöön kuului ensin paatin lumityöt, 
seitsemän sentin lumikuorman harjaus 
kuomulta ja täkiltä. 

Ei taida kesäveneilijä tunnistaa alka-
van talven paattimanööverejä. Suurin 
ongelma pakkasaamun lähdössä on 
ohjauskaapelin teleskoopin jäätymi-
nen, jota kaasusytyttimellä sulatellaan, 
jotta rattiohjaus toimisi. Ja tehokkain 
tapa puhdistaa paatin pohja levästä ja 
näkeistä on teräsjäissä ajo. Aina on va-
rauduttava siihen, että mantereen pak-
sukin lumipeite hupenee Lahdenaukean 
jälkeen olemattomaksi meren lämmöstä. 
Kylmäpihlajan nettikamera on poistanut 
tämän arvailun. 

Kattava kuva-aineisto kotosaariston 
ensilumesta on olemassa vaikka pieneksi 
kirjaksi asti. Lopetin ensilumen kuvaa-
misen oman paatin avuin tähän syksyyn. 
Muualle tai muiden kyytiin voin lähteä.    

Useat talviretket ovat kirkkaina muis-
tissa. Sekin kun lintuharrastuksen aloit-
tamisen kymmenvuotisretkellä 1982 kä-
velin kotoa yli 20 asteen pakkasaamuna 
Lehmänleton tamholtille. jota ei enää 
ole.

Aamuinen helmikuun turkishuurre 
peitti puut ja pensaat ja iltapäivällä oli 
huikaiseva talvipäivän sini. Filmiä ku-
lui ja kameran patterit hyytyivät, mutta 
mies ei. Nyt on päinvastoin vaikka töis-
sä prässinsä kadottaneet teryleenihousut 
ovat vaihtuneet untuvaan. Pakkasella 
suurin kuvausongelma on hengityshöy-
ryn jäätyminen silmälaseihin.  

Laskeva maaliskuu pakkasessa 1993 
pookin taakse mereen edellytti vielä il-
lalla käytetyn Valkkikarin väylän ylitys-
tä aamuyöllä mahallaan suksienpäällä. 
Tai kun piti pyöräillä Maanpään kautta 
Kuuskajaskarin linnakkeen jäälossille 
päästäkseen Louttujen saaristoon. Kyl-
mäpihlajalle meno jäitse edellytti kun-
non talvia, kuten olivat vuodet 1985 
- 1988.   

Tällä vuosituhannella on ollut vain 
kolme aitoa talvea valottaa saaristoa 
kuviksi. Vuoden 2003 talvi mahdollisti 
minulle pitkäaikaisen haaveen hiihtää 
yli pohjoisen Ahvenanmeren. Viikko 
hujahti eteläisen Suomen viimeisessä 
erämaassa ja yöt vanhoissa kalamajoissa 
menneiden kuiskeita kuullen. Painava 

6x7- kamera antoi kaksi kelpo kuvaa. 
Ei viikon retkeltä pidä enempää vaatia.

Vuosien 2010 ja 2011 talvina tein 
retket kaikkien käymään Saaristomeren 
Jurmon ja Utön saariin. Säät suosivat ja 
tuottivat muutaman laatukuvan, jotka 
nuoriso olisi jo paikalta lähettänyt net-
tiin ihasteltavaksi, mutta ikääntynyt 
kuvaaja hautoo ja hykertelee odottaen 
sopivaa julkaisua.

Yhtä tärkeää kuin saada valokuvia 
ensilumesta on minulle ollut tallentaa 
Rauman saariston jäiden lähtöä. Kaikki 
ahtojääkeväät näillä rannoilla: Nurmek-
sen fyyri 1977, Kalla 1981, Väliputaa 
1987, Prootti 1986, 1996, 2003 ja en-
nätysröykkiöt Isolla Siliöllä 2011 tuli 
käytyä haahkojen muuttoa seuraten. Se 
onkin sitten toinen tarina.

Yhden valokuvaajan maastokestävyys-
aika on riittämätöntä arvioon arkkipela-
gin talvista, mutta 2000-luvun kehnot 
jäät ja lumet saaristossa ovat surettaneet 
ja epäilyksiä herättäneet. Jääkö kuvaajan 
vuoden graafisin jakso entistä lyhyem-
mäksi ja huonommaksi samalla kun väli-
neet mahdollistaisivat entistä osuvampia 

Jäätyvän tai sulavan jään reuna on elävää luonnon grafiikkaa varsin vaihtelevin muodoin Yllä Tuulen jälkiä talvi-illassa Saaristomeren ulkoluodoilla, alla Talvinen ruovikko houkuttaa kuvaajaa sommitteluharjoituksiin. 
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Öinen lumisade on vaihtanut saariston valkeisiin lakanoihin Kuusisessa Suokarissa Korkeimmat ahtojäät Raumanmerellä neljään kymmeneen vuoteen, yli 11 metriä merenpinnasta, kohosivat Isolle Siliölle keväällä 2011

kuvia. Ovathan saaristokuvaajan ongel-
mat silti muutoksessa vähäisimpiä.

Rauman pohjoinen saaristo ei nyky-
äänkään jäädy atomivoiman lämpimän 
tuhlausveden vuoksi. Kävin 28.10.2012 
ensilunta kuvaamassa Susikarin laelta 
samasta paikasta kuin 1982. Jo Ristin-
perän suntissa lämmin löyhäys tömähti 
kasvoihin paatilla ajaessa ja huuru nousi 
lämmitetystä merestä. Entä kun uusi 
mylly joskus kaksinkertaisin lämpökuor-
min virtaa Raumanmereen. Ja ehkä sen 
jälkeen väsätään vielä neljäskin laitos.

Jäätyykö Raumanmeri sitten enää? Ai-
nakaan kukaan ei koskaan enää pyöräile 
Susikareihin kuvaamaan jäitä myöden 
huhtikuun puolivälissä kuten tein 1978!
         

               
Raimo Sundelin

Olem paljaskonttine raumlaine sualase 
veden kuvaaja. Saariston kuvaamisen 
aloitin 1975 ja valokuvaan kaikkea pu-
nalevävyöhykkeen yläpuolella olevaa ja 
sinisimpukkaa suurempaa. 

Kiinnostavana koen maiseman vuo-
denaikais- ja valovaihtelut. Läheiseksi 
ovat tulleet saariston geologia, menneen 
saaristolaiselämän jäänteet sekä majakat 
ympäristöineen. Lintuja kuvaan hakeu-
tumalla lintujen luo ja kasvit kuvaus-
mahdollisuuksineen ovat tulleet tutuik-
si sadoilla retkillä ja sadoilla käydyillä 
luodoilla. 

Suomen Lounainen arkkipelagi on 
ehtymätön kuvattavaksi, silti on hou-
kuttanut käydä myös muilla vesillä. Tänä 
vuonna esim. kolmatta kertaa Huippu-
vuorilla.    

Kuvia kysytään hyvin erilaisiin koh-
teisiin. Tarvekirjosta kertovat kuvat mm. 
jokaiseen talouteen jaetun katekismuk-
sen kymmenen käskyn taustakuva, Neu-
vostoliiton tiedeakatemian lippulaivan 
kapteeninhuoneen taulu ja vuoden 2012 
Helcomin kalenterin kansikuva.

Kuvaesityksiä pidän säännöllisesti niin 
valtakunnallisissa tapahtumissa suurilla 

estradeilla kuin pienien yhdistysten ko-
kouksissa, kysynnän ja oman mielialan 
mukaan. Yksi viimeisimpiä oli Viron 
Matsalun kansainvälisillä filmifestivaa-
leilla tänä syksynä. Sama kaava koskee 
näyttelyitäni. 

Mieluiten kuviani saa käyttötarkoituk-
siin, jotka eivät kovasti kohota brutto-
kansantuotetta. 

Sain nyt itsenäisyyspäivänä Rauman 
kaupungin kulttuuripalkinnon 2012

Artikkelin kirjoittaja Raimo Sundelin on laajalti tunnettu,  arvostettu ja palkittu  
luontokuvaaja ja tietokirjailija. Hän on myös seuramme pitkäaikainen jäsen, joka 

tänä vuonna tuli kahdesti palkituksi kotikaupungissaan kulttuurin saralla. Ensin 
Kameraseuran jäsenenä Länsi-Suomen Kulttuurimitalin myötä ja sitten vielä omana 

itsenään saamalla tämänvuotisen Rauman kaupungin kulttuuripalkinnon. Seuraavassa 
Raimo kertoo hieman itsestään ja kuvaamisestaan. 

Raimo Sundelin

Raimo Sundelinin omakuva ,  joka on otettu 20 sekunin viiveellä,  Raimo kertoo siirtä-
neensä viiveen 20 sekuntiin täytettyään 60 vuotta. Kuva on vuoden 2010 ensilumilta   
taustanaan Pöllän suntti,  joka on hänelle tuttu jo 1950-luvun kesäisiltä souturetkiltä. 
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Jäsenlehtemme päätoimittajan vinkistä 
lähdin haastattelemaan pitkän lehtikuvaa-
jauran tehnyttä Raimo ”Rami” Iso-Ettalaa. 
Puhelimessa sovimme haastatteluajan ja mies 
moneen kertaan mainitsee vaatimattomuu-
destaan. Totuus oli kuitenkin toinen. Pari 
tuntia varaamani aika kului siivillä ja lopulta 
minulle tuli kiire ehtiä töihin. 

Iso-Ettala on syntyisin Kalannista, Hallun 
kylästä Nissilän tuvassa, niin kuin mies itse 
asian haluaa ilmaista. Keskikoulun hän kävi 
Rauman Lyseossa, jonmka jälkeen aika kului 
äidin kotitilan maataloustöissä.

Kertyneillä taskurahoilla Iso-Ettala oli 
hankkinut ensimmäisen kameran. - Kesäl-
lä 1958 perheemme teki polkupyöräreissun 

Ahvenanmaalle. Tuolla reissulla otin ensim-
mäiset kuvani, Rami muistelee.

Lehtikuvaajan uralla päätymisestä Iso-
Ettala saa kiittä edesmennyttä äitiään. - Äi-
tini oli nähnyt Länsi-Suomessa ilmoituksen, 
jolla lehteen haettiin valokuvaajaharjoitteli-
jaa. Kävin mopollani toimituksessa, mutta 
käynnistä ei jäänyt kovin vahvaa tunnetta. 

Viikkoa myöhemmin Länsi-Suomen lähetti 
tuli tuomaan tiedon, että huomenna pitäisi 
tulla töihin. Tuo päivä oli 24.9.1965.

Länsi-Suomen vuosiin sisältyy myös varus-
miespalveluksen suorittaminen. 

Armeija-aikanakin halu oli päästä Ilma-
voimien Kuvakeskuksen varusmieheksi Tik-
kakoskelle. Tie vei sinne kuitenkin mutkan 
kautta. - Aloitin palveluksen Satakunnan 
Lennostossa Porissa, josta sitten pääsin ku-
vauskurssille ylimääräisenä oppilaana.

Kurssin jälkeen varusmiespalvelus koostui 
erilaisista kuvaustehtävistä niin ilmassa kuin 
maan pinnalla. - Yhdessä vaiheessa kapiaiset 
alkoivat tulla kuvattavakseni ja lopulta va-
rusmiehetkin. Mitään löysäilyä se homma 
ei ollut, sillä viimeiseen päivään asti minulla 

Ramin koti Raumalla on täynnä kuvia ja keittiön seinää koristaa kuva ortodoksi-
sesta kirkosta ja auringonpimennyksestä. Rami oli aluksi yrittänyt kuvata aurin-
gonpimennystä Näsinneulasta onnistumatta siinä.

TEKSTI PEKKA VÄKIPARTA, KUVAT PEKKA VÄKIPARTA JA RAIMO ISO-ETTALAN ARKISTO 

Raimo Iso-Ettala
oli lehtikuvaajana viidellä vuosikymmenellä

”Ensimmäisellä palkalla ei maksettu kuin mopon bensat

PekkaVäkiparta: Raimo Iso-Ettala

riitti kiirettä kuvaamisessa ja kuvien kehit-
tämisessä. 

Armeijan suoritettuaan Ramin työt jatkui-
vat siitä mihin ne olivat ennen varusmiespal-
velusta jääneet. Vuosien kuluessa lehtikuvaa-
jan palkka ei noussut kuin pyytämällä. - Va-
littelin asiaa kirjapainon työntekijälle, joka 
kertoi nähneensä Aamulehdessä ilmoituksen, 
jossa haettiin valokuvaajaharjoittelijaa. Mat-
kahuollosta lopulta löysin kyseisen lehden ja 
laitoin hakemuksen vetämään. 

Aamulehdessä haastatteluraatiin kuulu-
neet toimituspäällikkö, uutispäällikkö ja 
kuvalaattalaitoksen päällikkö tykästyivät 
mieheen, joka oli pyrkinyt vapaaehtoisena 
varusmiespalvelukseen jo ennen varsinaista 
ikää. - Ilmavoimien kurssitodistus samoil-

la pisteillä kuin kurssin priimus 
taisi vakuuttaa heidät, Iso-Ettala 
pohtii.

 Aamulehden palveluksessa 
Rami aloitti 1.11.1970. Hänen 
mukaansa tietokoneiden tullessa 
mukaan lehden tekoon oli eduksi, 
että oli kiinnostunut tekniikasta 
ja yhdessä vaiheessa olikin pakko 
opiskella kirjastojen kirjojen kaut-
ta kaikki mitä tietokoneinsinöörit 
höpisivät. - Yksi merkittävim-
mistä muutoksista tietokoneiden 
tulon myötä oli sähköisen kuva-
arkiston käyttöönottaminen. 

1980-luvulla tuli mukaan vä-
rikuvat. - Se oli haastavaa, sillä 
samaan aikaan piti ottaa sekä 
värikuvaa että mustavalkoista. 
Laitteet olivat kaiken lisäksi isoja 
ja raskaita,.

Vuosina 1993-1994 kameroi-
den koko muuttui Ramin mu-
kaan inhimillisemmiksi. 

Merkittävänä kehitysaskeleena 
kokenut lehtikuvaaja nostaa raa-
katiedoston tulemisen. - Tiivistet-
tynä tuolle kuvamuodolle voi teh-
dä kaikki muut korjaukset lukuun 
ottamatta tarkennuksen muutta-
mista. Miksei sekin aika vielä voi 
joskus koittaa, hän pohtii.

Aamulehden palveluksesta Iso-
Ettala jäi eläkkeelle päivälleen 40 
vuotta taloon tulonsa jälkeen. 
Raumalla Rami kunnosti van-
hempiensa kotitaloa vanhan hau-
tausmaan vieressä. Naapurit ovat 
innostaneet kunnostamaan puu-
tarhaa, josta kuvausaiheita löytyy 
mukavasti. - Olen huomannut, 

että luovuus lisääntyy itsestään. Esimerkiksi 
salamoiden käyttö onkin uusi mielenkiintoi-
nen aihealue.

Painetun sanomalehden katoaminen on 
Raimo Iso-Ettalan mukaan näköpiirissä. - Pai-
nettu sana on ollut vahva vaikuttaja, mutta 
se tulee nykymuotoisena katoamaan. Sano-
malehden muuttuminen broadsheet-koosta 
tabloidiin on vain viivytystaistelua. 

Pekka Väkiparta

Tamperen Hatanpäässä purettiin siiloja maaliskuussa 1998. Työn vaativuudesta kertonee. että toinen puomeista oli kuvanottohetkellä 
jo solmussa.
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Vasemmalla:  Yläkuvassa Aa-
mulehden Moro-viikkoliitteen 
toimittaja Olli Kemmo teki 
vaikka minkälaisia tutkimuksia 
kaupungilla ja missä vaan. 
Tässä tutkitaan elokuussa 1991 
Kalevan uintikeskuksen saunan 
lauteiden siisteyttä ihan 
aitojen satunnaisten saunojien 
alta, kun joku oli valittanut 
epäsiisteistä lauteista. Ala-
kuvassa Vuonna 2000 Raimo 
Iso-Ettalan onnistui tallentaa 
stuntman Jouni Kivimäki 
järjestämää polttaritoimintaa.  
Alla Ammattioppilaitoksen 
opiskelijoiden tulon jäl-
keen alkaneita asumisen 
jälkiä Hervannassavuonna 
2000: isännöitsijä Markus 
Paulasaari harmittelee 
siivouskaapin oven kohtaloa 
rappukäytävässä

Jääkiekkokaupungin lehtikuvaajana Ramin 
työvuosiin kuului myös jääkiekon kuvaamista. 
Tampereella huutamassa vuoden 2000 run-
kosarjan voittajajoukkue TPS:n päävamentaja 
Hannu Jortikka. 

Raimo Iso-Ettala: Asuminen

Miten innostuit va-
lokuvaamisesta?

Intissä tutustuin pariin valokuvaajaan. Intistä 
päästyäni ostin ensimmäisen kamerani, mut-
ta en kuvannut puoleen vuoteen juurikaan. 
Kun muutin Tampereelle kaksi vuotta sitten, 
innostuin konemusiikista ja aloin kuvata ko-
nemusiikkikeikkoja. Keikkoja on nyt tullut 
kuvattua noin 30.

Opiskelin yliopistossa ensin journalistiik-
kaa, mutta hain hetken mielijohteesta Kuva-
journalistiikan opinto-ohjelmaan yliopiston 
sivuainehaun kautta ja pääsin. 

Onko koulutusohjelma vas-
tannut odotuksiasi?

Onhan tämä hauskaa. Erityisesti vierailijoi-
den työpajat ovat olleet hyödyllisiä. Niissä 
on saanut tehdä omannäköisiä kuvia ja se 
on palkitsevaa.

Ensimmäisenä vuotena opiskellaan perus-
opinnot ja yhteisiä opintoja yhdessä jour-
nalistiikkaa ja viestintää opiskelevien kanssa 
eli opiskelu on aika teoriapainotteista. Nyt 
syksyllä opiskelu on ollut hyvin intensiivistä. 
Yliopistossa ollaan aamu yhdeksästä iltapäi-
vään neljään tai viiteen, ja kamera on ollut 
kädessä koko päivän. Kuvajournalistikoulu-
tuksen omaa Katse-lehteäkin tehdään paljon 
omalla ajalla. Sivuaineita ei voi edes ajatella 
ottavansa nyt, vaikka minua kiinnostaisi suo-
rittaa Sosiaalitieteiden opintokokonaisuus.

Opiskelu on kuitenkin antanut paljon. 
Olen oppinut näkemään asioita, joita ei 
muuten näkisi, josta on apua esimerkiksi 
katukuvauksessa. Olen oppinut myös tietä-
mään eri valokuvaajia ja näiden tyylejä.

Opintoihin kuuluu myös teknisten asi-
oiden, kuten kehystyksen ja heijastuksen, 
opiskelua. En ollut opiskellut valokuvausta 
aikaisemmin, joten itseoppineelle valokuvaa-
jalle kurssit ovat olleet tervetulleita.

Onko valokuviasi julkais-
tu lehdissä ja missä?

Viime kesänä olin töissä Suomen Golflehdes-
sä ja teen edelleen freelancerinä töitä lehdelle 
opintojen ohella. Ensimmäisen vuoden opis-
kelijoiden on vaikea saada alalta kesätöitä. 
Olen pelannut golfia pitkään, joten se auttoi 
saamaan lehdestä töitä.

Millainen on alan työtilanne?
Uskon, että tekevälle töitä riittää. Varsin-
kin, jos ottaa kaiken vastaan mitä tarjotaan. 
Tampereen yliopisto ja kuvajournalistiikan 
linja tunnetaan hyvin, joten valmistuvien on 
helppo saada töitä. Monet saavat töitä ennen 
kandidaatin tutkintoa ja osalla saattaa siksi 
jäädä opinnot kesken. Ongelmia työnsaan-
nissa voi olla niillä, jotka valmistuvat valoku-
vaajiksi muualta.

Mitä tykkäät kuvata?

Tykkään kuvata ihmisiä ja katukuvaus on 
mielenkiintoista. Minulla on aina kamera 
mukana. 

Tulevaisuudessa haaveilen saavani tehdä 
ihmisistä kertovia juttuja enemmän kuin 
pelkkää uutiskuvausta. Ihannetapaus olisi 
se, että omat projektit työllistäisivät tai että 
voisi perustaa kavereiden kanssa pienen ku-
vatoimiston. Mutta hienoa olisi päästä töihin 
johonkin arvostettuun lehteen.

Millä kameralla kuvaat?

Canon 50D:llä.

Kuvajournalistiikan linjalle haki tänä vuon-
na 234, joista pääsykokeisiin osallistui 80. 
Hyväksyttyjä oli 6. Joka kevät opiskelijava-
lintaa täydennetään sivuainehaulla, jolloin 
valitaan neljä opiskelijaa. Opinnot alkavat 
seuraavana syksynä samassa ryhmässä KJL:n  
pääaineopiskelijoiden kanssa.

Esimerkkejä oppilai-
toksista, joissa voi opis-
kella valokuvausta:
Tampereen yliopisto: Kuvajournalismi 
http://www.uta.fi/cmt/kuvajournalismi/in-
dex.html

Jyväskylän ammattiopisto: Valokuvauksen 
koulutusohjelma www.jao.fi

Satakunnan ammattiopisto: Kuvallisen il-
maisun koulutusohjelma http://sataedu.fi/fi/
ammattiopisto/nakkila

Keski-Pohjanmaan Opisto: Valokuvauslinja 
http://www.kpopisto.fi/

Muurlan Opisto: Valokuvauslinja http://
www.muurlanopisto.fi/muurla/

Paasikivi Opisto: Valokuvauksen opintolin-
ja http://www.paasikiviopisto.net/

Lahden ammattikorkeakoulua/Muotoilu- 
ja taideinstituutti: Valokuvaus http://www.
lamk.fi/muotoilujataide/koulutus/Sivut/de-
fault.aspx

Aalto-yliopisto: Valokuvataiteen koulu-
tusohjelma http://media.aalto.fi/fi/studies/
programs/photography/

Aleksista   puolestaan tulee

TEKSTI JA KUVA ANNE PERTTULA 

Aleksi Tuomola, 23, opiskelee toista vuotta 
Tampereen yliopiston Viestinnän, median 
ja teatterin yksikössä kuvajournalistiikkaa. 

Miellyttäväksi haastateltavaksi osoittautunut Aleksi 
opasti haastattelijaakin sekä kuvanottamisessa että 

kameran käytössä.

   lehtikuvaaja
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den gigatavun korttien tultua markkinoille.  
CompactFlash-korteissa voidaan käyttää 
mitä tahansa järjestelmän tukemaa tiedos-
tojärjestelmää.

Tiedonsiirtonopeuden pullonkaulana voi 
olla myös siirtoväylän nopeus. Tässä yhte-
ydessä nostetaan esille termi UDMA (Ult-
ra Direct Mode Access), jolla kuvataan siis 
tiedonsiirtonopeutta, millä dataa voidaan 
kortille välittää. Tällä hetkellä on yleisesti 
myynnissä UDMA 6, jolla on teoreettisesti 
siis mahdollista päästä 133 Mt/s nopeuteen 
(886x). Tämä ei siis riitä aivan uusimmille 
1000x nopeuteen yltäville korteille, vaan niis-
sä on oltava UDMA 7, jotta täysi tiedonsiir-
tonopeus olisi saavutettavissa.

XQD

CompactFlash Assosiationin vuoden 2011 
lopussa julkistama uusin muistikorttifor-
maatti on nimetty XQD:ksi. XQD:ssä käy-
tetään PCI-Express -liitäntää, jossa väylätek-
nisesti suurin tiedonsiirtonopeus on teoriassa 
2,5 Gb/s (312,5 Mt/s) tai myöhemmässä 
vaiheessa 5 Gb/s (625Mt/s). 

Fyysisesti XQD asettuu CompactFlashin 
ja SD:n väliin ja kotelointi on määritelty 
jämäkäksi ja kulutusta kestäväksi. Valmis-
tajat ilmoittavat teoreettisen siirtonopeuden 
korteissa suoraan, joten mitään kertoimia tai 
luokkia ei korteissa ole.

Nikonin D4 oli ensimmäinen kamera, 
jossa tämän formaatin korttipaikka löytyy. 
Kyseisessä kameramallissa on myös Com-
pactFlash-paikka. Markkinoilla on tällä het-
kellä ainakin kortteja 16 Gt koosta ainakin 
64 Gt kokoon asti, mutta teoreettiset rajoit-
teet tulevat vasta kahdessa teratavussa.

Formaatin nopeutta ollaan kasvattamassa 
tulevaisuudessa, sillä suunnitteilla olevassa 
XQD 2.0 spesifikaatiossa liitynnässä kiih-
dyteltäisiin 8 Gb/s (1000 Mt/s) nopeuksilla. 
Ulkoisiin ominaisuuksiin ei olla koskemas-
sa ja muutenkin uusi versio tulee olemaan 
yhteensopiva tällä hetkellä käytössä olevien 
laitteiden kanssa.

aiheuttaa mahdollisesti käytetty exFAT-tie-
dostojärjestelmä. Tätä Microsoftin kehit-
tämään formaattia ei ole annettu julkiseen 
käyttöön, vaan se olisi rahalla lisensoitava.

Kaikille SD-korteille ilmoitetaan nopeus-
luokka (class), joka on pienin kirjoitusno-
peus, jolla tyhjälle kortille pystytään kirjoit-
tamaan. Tämä ilmoittaa vain määritellyn 
luokan, jonka vaatimukset kortti täyttää ja 
siten missä toiminnassa sitä voidaan käyttää. 
Esimerkiksi HD-videokuvaukseen vaaditaan 
Class 6 -luokituksen kortti. Todellinen tie-
donsiirtonopeus voi olla sitten jotain ihan 
muuta ja valmistaja ilmoittaa sen erikseen 
x-luokituksella tai Mt/s -merkinnällä.

SD-korttien nopeuksia sekoittaa uutena 
määrittelynä Ultra-High Speed (UHS), jo-
ta voi löytyä uudemmista SDHC ja SDXC 
-korteista. Tällöin kortilta löytyy iso i-kirjain 
symboloimaan tätä ominaisuutta. UHS-I 
määritellyllä kortilla suurin nopeus on 104 
Mt/s ja UHS-II -kortilla jopa 312 Mt/s. Näil-
lä korteilla valmistajat ilmoittavat suoraan 
Mt/s -merkinnällä teoreettisen maksimino-
peuden.

SD-korttien hyvä puoli on esimerkiksi 
kannettavissa tietokoneissa yleistynyt kor-
tinlukija, joten matkassa ei välttämättä tarvita 
erillistä lukijalaitetta. 

CompactFlash

SanDisk aloitti CompactFlash-korttien 
valmistuksen jo vuonna 1994. Kortteja on 
määritelty kahta eri tyyppiä, ja ne poikkeavat 
toisistaan vain fyysisen paksuuden suhteen. 
Yleisempi tyypin yksi kortti voi olla 3,3 mil-
limetriä paksu, kun taas tyypin kaksi paksuus 
voi olla 5 millimetriä. Liitinnastojen kolot 
ovat identtiset, joten mitään erillistä muun-
ninta ei tarvita, jos kortti vaan sille varattuun 
koloon mahtuu.

CompactFlashin sisällä voi olla Flash-
muistitekniikkaan perustuvat muistipiirit 
tai pienikokoinen kiintolevy (MicroDrive).

Yleisimmin tiedostojärjestelmänä käyte-
tään standardin suosittelemaa FAT32:sta, 
joka on korvannut aiemman FAT16:n kah-

xD -korteille on tosin ennusteltu kuolemaa, 
kun Fujifilmi lisäsi valmistamiinsa kameroi-
hin tukea myös SD-korteille. Muistikorttien 
pakkaa on tullut sekoittamaan uusimpana tu-
lokkaana XQD, joka esiteltiin CompactFlash 
Association -järjestön toimesta.

Myöhemmin esitetyt tiedonsiirtonopeudet 
ovat teoreettisia, eikä ilmoitettuun nopeuteen 
päästä kuin satunnaisesti ja optimiolosuh-
teissa. Eri tekniikoiden väliseen vertailuun 
niitä voidaan käyttää, tosin pienin varauk-
sin. Myös eri valmistajien välillä saattaa olla 
suuriakin eroja. Kannattaa ostovaiheessa etsiä 
internetistä kokemuksia eri valmistajan kor-
teista, eri valmistajien, kuin myös eri mallien, 
välillä kun on paljonkin eroa nopeuksissa ja 
luotettavuudessa.

Secure Digital

SD-kortin tekniikka julkistettiin vuonna 
1999 ja siitä on sen jälkeen tullut yksi suo-
situimmista muistikorteista maailmanlaajui-
sesti.  SD-korttiperheessä on myös fyysisesti 
pienempiä kortteja, mini ja micro. Näitä 
käytetään pääsääntöisesti matkapuhelimissa 
ja ne ovat liitettävissä adapterikortin kanssa 
normaaliin SD-korttipaikkaan. MMC-kortit 
ovat myös osittain fyysisesti yhteensopivia 
SD-liityntöjen kanssa.

Ensimmäisen sukupolven SD-korttien tal-
lennuskapasiteetti rajoittui 4 Gt kokoon ja 
sen vuoksi kuluttajia sotkemaan on tullutkin 
SDHC (Secure Digital High Capacity) ja 
SDXC (Secure Digital Extended Capacity) 
-kortit. Nämä ovat fyysisesti samankokoisia 
SD:n kanssa.

SDHC-formaatissa kortin tallennuska-
pasiteetti kasvoi 32 Gt:n ja tiedostojärjes-
telmäksi tuli FAT32. Lukijalaitteiden ja 
-järjestelmien pitää tukea tätä formaattia. 
Esimerkiksi Windows XP vaati erillisen 
pienen päivityksen ennen suurempaa SP3-
päivityspakettia. 

SDXC- korttiformaatti julkaistiin 2009. 
Suurin muutos oli tallennuskapasiteetin kas-
vu kahteen teratavuun. SDXC on yhteenso-
piva SDHC:n kanssa, mutta ongelmia saattaa 

Asiaa muistikorteista
TIMO VAAHTERA

ESIMERKKEJÄ TIEDONSIIRTONOPEUKSISTA

Nopeus Luokka (SD) Kerroin (CF)

0,9 Mt/s Class 1 6x
2 Mt/s Class 2 13x
4 Mt/s Class 4 26x
4,8 Mt/s 32x
6 Mt/s Class 6 40x
10 Mt/s Class 10 66x
15 Mt/s 100x
20 Mt/s 133x
40 Mt/s 266x
50 Mt/s 333x
60 Mt/s 400x
90 Mt/s 600x
100 Mt/s 666x
150 Mt/s 1000x

UDMA-luokkien nopeudet

UDMA NOPEUS

0 16,7 Mt/s
1 25 Mt/s
2 33,3 Mt/s
3 44,4 Mt/s
4 66,7 Mt/s
5 100 Mt/s
6 133 Mt/s
7 167 Mt/s

Oikeanpuoleisessa  taulukossa kerroin 
on vastaava kuin CD-asemissa käytetty 
luku- ja kirjoitusnopeuden määritelmä. 1x 
vastaa 1,2 megabitin siirtoa sekunnissa ja 
muut ovat tämän kertoimia (esimerkiksi 
40 * 1,2 Mb = 48 Mb = 6MB). Kortin kirjoi-
tusnopeus voidaan kertoa myös suoraan 
Mt/s -yksiköissä.

Tällä hetkellä yleisimmät muistikortit digitaalikameroissa ovat Secure Digital (SD) ja 
CompactFlash (CF). Näiden lisäksi on myös Olympuksen ja Fujifilmin kehittämä xD-
Picture Card -kortteja, Siemensin ja SanDiskin kehittelemä MultiMediaCard (MMC), 

sekä Sonyn Memory Stick -muistikorttiperhe.

Meil ilmestys kissanpentu. Se tul Porist, sielt-
äkki joskus tulee jotta mielust. Poriserkku sen 
toi lahjaks mnuu pojallen, hän näättäk täyt 
50 vuot. Ny o kis yhde vuade vanh ja saanu 
nimeks Zili. Mnuu määrätti Zilin päivähoi-
tajaks ko ole eläkevaar ja samast pihapiirist, 
kuulem ny o aika tehd tämmöstäkki homma. 

Aluks katteli ko pentu harjottel tekohii-
re kii ottamist. Hyppelyi ol hausk seurat ja 
nii mä hänest rupesi kovast tykkämä. Mnää 
suomensi viel kissa nime. Zili o hän. Ny hän 
kaike yät metsästä hiirei, nuuski kaik nurka 
ja puska. Päiväl hän tulee nukkuma meijä 
keinustoolihi ja hän vaati ett hänt krapsutella 
unehe. Välist hänt ko kutsu kissaruokka syö-
mä hän nuuski vaa ja lähte kävelemä poispäi, 
ei sen pualest en mnääkä kissaruokka söis. 
Annast ol ku mnää tarjo stää kaupa kallist 
makkara, hän ahmi stää nii ett mnää ajat-
le, jätäis vähä mullekki. Nii ja kaverei hänel 
näyttä piissava. Välist kaksiki kissa naapureist 
o meijä pihal kyttämäs misä hän o. Mnuu 
tekis miel niil sanno, naaraskissat älköön vai-
vatuko näättäk hän o leikattu uroskis. Täsä 
kerra mnuu vaimon kysel, minkä arvoinen 
ma sulle olen. Mnää vastasi koht. Ensmäi-
teks, tulee hän Zili. Toiseks, mnuu digikame-
ran ja kolmanneks snää sit tule. Näättäks ei 
kysyn enää rakas vaimon toist kertta. 

Pekka Urponen

TEKSTI JA KUVAT PEKKA URPONEN Hän o Zili
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Jotkut kuvaajat ottavat ruokakuvansa vain 
studiossa, josta löytyy täydellinen valaistus-
järjestelmä ja taustat. Jotkut käyttävät vain 
matalalta siivilöityvää päivänvaloa aamu- tai 
iltapäivällä. Joidenkin mielestä lautasen suo-
raan ylhäältä kuvaaminen on suurin virhe, 
jonka voi tehdä, toiset taas eivät näe siinä 
mitään kummallista. Itse kuvasin ravintola 
Sopissa päivänvalolla ja salamoilla ja hehku-
lamppujen sekavalossa. Kerta kaikkiaan mie-
lenkiintoista. Ja koska Sopin sisustus korreloi 
värikkäiden annosten kanssa, halusin ottaa 
ympäristön mukaan. Välineinä oli Nikon 
d300s, kaksi käsisalamaa, heijastin, jalusta, 
50mm ja 18-200mm plus macro.

Internetistä olin löytänyt muutamia vink-
kejä:

- Kuvaa alhaalta. Annoksen majesteetil-
lisuus kasvaa, kun annos näyttää kohoavan 
taivaisiin. Ylhäältä kuvatessa tulee latistettua 
tulosta, sopii ehkä räiskäleisiin. Terävyysalu-
een ei tarvitse olla suuri, houkuttelevuuteen 
voi riittää yksi terävä marja jälkiruuassa.

- Ota kaveriksi suuri ikkuna. Valo on 
pehmeää ja jalustan kanssa se riittää pie-
nemmillekin aukoille. Kuvaa ensin pääva-

lolla ja päättele sitten, tarvitaanko täytevaloa 
varjokohtiin. Kontrastikkaampi jäätelö on 
syötävämpi kuin täyskuupallo.

- Kylmä ruoka höyryämään sukalla. Kostu-
ta puuvillasukka, tai tamponi, tunge se mik-
roon minuutiksi, piilota se lautasen taakse: 
voilà! Ruoka on lämmin. Innokkaana kokei-
lin, sukalla tällä kertaa, mutta ei toiminut. 
Erilaisilla valaistusolosuhteilla tai paremmalla 
kokemuksella olisi saattanut onnistuakin.

- Kattaus. Sen täytyy olla tarpeeksi vaa-
timaton, jotta itse ruoka vangitsisi silmän. 
Värikkyysteema näkyy muutamissa kuvissa 
ehkä liiankin, soppimaisuus näkyy pöytä-
liinoissa, tuoleissa, laseissa, seinillä ja katossa, 
mutta tokihan jännittävä miljöö tekee ruuan 
nautittavuudesta ainakin kolmanneksen. Oli 
alusta asti selvää, että värikkyyden täytyy nä-
kyä kuvissa. 

Kuvatessa vaihtelin valaistusta, paikkaa, 
kuvakulmaa, polttoväliä, joten mistään lis-
takuvauksesta ei voi puhua. Ruokakuvauk-
seen voikin soveltaa kaikkia valokuvauksen 
osa-alueita: macrokuvausta kahvinpavuille, 
dokumenttikuvausta kahvinhörppijälle, 
muotokuvausta tähtianikselle, luontokuva-

usta ruokalautaselle taustaympäristöineen, 
taidekuvausta jälkiruualle ja urheilukuvausta 
- no, siihen se sitten tyssäsikin. Joka tapa-
uksessa mitkään keinot eivät ole liioiteltuja 
ruokakuvauksessa. Maailmalla tehdään ruo-
kakuvia tyyliin: kokki kokkaa ja asettelee 
ruuan, kuvaajan assistentti assistoi kuvaajaa, 
kattausstylisti järjestelee haarukat ja lautas-
liinat, mainosgraafikko varmistaa kokonai-
suuden ja kahvinkeittäjä valmistaa sumpit 
koko köörile. Niin, onhan se valokuvaajakin 
siellä. Ja koko päivänä syntyy neljä kuvaa. 
(esimerkki julkaistu The Guardian -lehden 
verkkosivuilla 1.7.12)

Loppupäätelmänä voisi sanoa, että kan-
nattaa kokeilla. Vaikeampaa, miltä näyttää, 
paitsi jos kuvaa suurella asenteella pelkästään 
ikkunanvalolla. Toinen asia on sitten se, kuka 
ne annokset taiteilee. Jos kaipaat haastetta, 
kuvaa kaurapuuroa.

Teemu Laulajainen

Ruokakuvaus ravintolamiljöössä:

Kahvila Soppi
Voisi luulla, että ruuan 

kuvaaminen on helppoa, koska 
kohde pysyy paikoillaan ja 

sitä voi siirrellä haluamaansa 
paikkaan. Annoksia voi 

sommitella houkuttelevaksi ja 
sen voi tehdä värikkääksi.

Sanomalehti Länsi-Suomi palkitsi 
Rauman Kameraseuran kulttuu-
rimitalilla. Perusteluina valinnalle 
oli hurja jäsenmäärän kasvu ja 
toiminnan aktivoituminen. Mitali 
luovutettiin sanomalehti Länsi-
Suomen 107v juhlissa Kivikyläaree-
nalla  4.12 pidetyssä tilaisuudessa. 
Kameraseuran hallitus haluaa 
kiittää kaikkia seuran jäseniä 
uskomattoman hienosta vuodesta, 
sillä ilman teitä kaikkia ei olisi ollut 
mahdollista saavuttaa tätäkään 
palkintoa.

R K S : l l e  L ä n s i - S u o m e n   k u l t t u u r i m i t a l i ! 

Lappeenrannan teekkareiden kameraker-
hon vuonna 2001 järjestämä teemanäyttely 
”Tieto” oli ensimmäinen Suomen Kamera-
seurojen Liiton näyttely, jonka avajaisissa 
allekirjoittanut sai olla mukana. Sen jälkeen 
olenkin saanut olla todistamassa monia tee-
ma- tai vuosinäyttelyn avajaisia mm. seuraa-
villa paikkakunnilla: Vammala, Valkeakoski, 
Hyvinkää, Lappeenranta, Ylivieska, Kouvola, 
Helsinki, Tampere, Hämeenkyrö ja Naantali. 

Liiton näyttelyistä varsinkin vuosinäyttely 
on melko kattava läpileikkaus suomalaisesta 
harrastajavalokuvauksesta, sillä sen teemaa 
ei ole rajoitettu millään tavalla. Näyttelyihin 
tarjotaan 800-1000 kuvaa, joista järjestävän 
seuran valitsema jury valitsee omannäköi-
sensä näyttelyn. Kuvien läpimenoprosentti 
vaihtelee lähinnä näyttelytilan koon mukaan. 
Näyttelyihin voi tarjota sekä ripustettavia, et-
tä digikuvia. Näyttelyn avajaisia edeltää suuri 
määrä talkootunteja, kun ympäri maata tule-
vat kuvalähetykset pitää ihan ensimmäiseksi 
luetteloida ja järjestää tuomarointia varten. 
Tuomaroinnin jälkeen on vuorossa vedosten 
reproaminen ja näyttelyluettelon taittami-
nen, sekä tietenkin kuvien kehystys ja ripus-
tus. Kun kaikki on valmista ja on avajaisten 
aika, niin usein ympärillä onkin väsyneitä, 
mutta onnellisia järjestävän seuran jäseniä 
ja maljoja nostellaan sekä puheita pidetään. 
Monet seurat myös käyttävät tilaisuutta hy-
väkseen ja palkitsevat ansioituneita jäseniään 
Kameraseurojen Liiton ansiomerkeillä.

Muutaman vuoden tauon jälkeen päätin 
taas suunnata liiton teemanäyttelyn ”Työ” 
avajaisiin, joka tällä kertaa järjestettiin Hy-
vinkäällä paikallisen seuran 60-vuotisjuhlien 
kunniaksi. Yksi motivaattori Hyvinkäälle läh-
temiseen oli tietenkin Vuoden Kameraseuran 
julkistaminen liiton syyskokouksessa, sillä 
olihan Rauman Kameraseura myös kilvoit-
telemassa tuosta tittelistä. Toki mielessäni oli 
myös meitä vuoden päästä odottava urakka 
vastaavan näyttelyn järjestämiseksi. Hyvin-
kään näyttelyn järjestelyissä vahvasti mukana 
ollut Salmisen Pekka lupailikin meille hyvän 
tietopaketin näyttelyn järjestämisestä.

Teemanäyttelyn kuvat oli pystytetty van-
han villatehtaan tiloihin saneerattuihin Hy-
vinkään Kaupungintalon tiloihin. Tila olikin 
todella hieno ja avara. Kuvia oli esillä kahdes-
sa kerroksessa ja myös digikuvat pyörivät mo-
lemmissa kerroksissa vieläpä niin, että pys-
tykuvat pyörivät omissa pystyyn nostetuissa 
telkkareissaan ja vaakakuvat omissaan. Hieno 
oivallus sanoisin. Hyvinkään kaupungin ja 
kameraseuran edustajien puheiden jälkeen 

Suomen Kameraseurojen Liiton puheen-
johtaja Reino Havumäki jakoi kunniakirjat 
näyttelyssä menestyneille. Maljoja kilisteltiin 
ja naposteltiin pikkusuolaista. Samassa ra-
kennuksessa oli esillä myös toinen hieno va-
lokuvanäyttely, kun Hyvinkään Kameraseu-
ran ja Kameraseura ry:n pitkäaikaisen jäsenen 
Heimo Harjun retrospektiivinen näyttely oli 
pystytetty Villan Voimala -nimiseen näytte-
lytilaan. Esillä oli toinen toistaan hienompia 
ajankuvia 50-luvulta tähän päivään.

Avajaistilaisuuden jälkeen oli seuratoimin-
taseminaari Hotelli Sveitsissä ja aiheena liiton 
seuroille tarjoamat kotisivupalvelut. Tilaisuu-
dessa liiton kotisivuvastaava Tatu Kosonen 
luennoi mm. seurojen mahdollisuudesta 
lisätä omia uutisiaan liiton kotisivuille. 

Näyttelyn avajaisviikonlopun ohjelmaan 
kuuluu perinteisesti myös juhlaillallinen, 
joka nautittiin niin ikään Hotelli Sveitsin 
tiloissa. Illallisella jaettiin vielä loput muis-
tamiset paikalliselle kameraseuralle ja toki 
pöytäseurueissa keskusteltiin myös erilaisista 
yhteistyömahdollisuuksista muiden kame-
raseurojen kanssa. Raumalaiset saivat mm. 
kutsun Loviisan Kameraseuran vieraaksi. Ai-
na näin vaalikokouksen alla on myös pientä 
lobbausta havaittavissa liiton hallituspaikkoja 
ajatellen.

Sunnuntaina olikin sitten vuorossa liiton 
syyskokous, jossa siis valitaan tulevan kau-
den hallitus, käydään läpi tulevan vuoden 
toimintasuunnitelma sekä talousarvio. Ko-
kous kuitenkin aloitettiin vuoden Kamera-
seuran julkistamisella. Liiton puheenjohtaja 
Reino Havumäki esitteli hakemukset, joita 
oli kolme, paikalla olleille ja julkisti lopuksi 
Rauman Kameraseuran voittajaksi. Peruste-
luina olivat hurja jäsenmäärän kasvu ja toi-
minnan aktivoituminen kaikilla osa-alueilla, 
sekä lehden muotoon taitettu persoonalli-

nen hakemus. Yhtään kotiinpäin vetämättä, 
niin aika kovat näytöt olisi vaadittu joltain 
muulta seuralta, mikäli olisivat halunneet 
meidät päihittää. Saimme palkinnoksi siis 
1000 euron arvosta liiton koulutuspalveluita, 
mutta meitä myös velvoitettiin kertomaan 
liiton kevätkokouksessa Tampereella muiden 
kameraseurojen edustajille, että miten me 
tämän kaiken olemme saaneet aikaiseksi.

Kokous itsessään sujui melko normaalin 
kaavan mukaan. Reino Havumäki jatkaa 
liiton puheenjohtajana myös vuonna 2013. 
Hallituksesta erovuorossa olivat Leena-Maija 
Lindgvist ja Sakari Mäkelä jr. Erovuoroisista 
Leena-Maija ilmoitti, ettei enää asetu ehdol-
le, mutta Sakari lupautui jatkamaan nuori-
sovastaavana, mikäli kokousedustajat näin 
päättäisivät. Liiton hallituksen esityksestä 
hallituksen jäsenmäärää päätettiin kasvattaa 
yhdellä henkilöllä kansainvälisen toiminnan 
vilkastumisen vuoksi. Kuulemani mukaan 
pitkästä aikaa jouduttiin myös äänestämään, 
kun liiton hallituksen kokoonpanoa seuraa-
valle vuodelle valittiin, sillä ehdokkaita oli 
enemmän, kuin paikkoja oli vapaana. Jäsen-
seuroilla on käytettävissään ääniä jäsenmää-
rän mukaan, eli mitä enemmän jäseniä, niin 
sitä enemmän myös ääniä. Sakari jr valittiin 
kahden vuoden jatkokaudelle ja uusina hal-
litukseen valittiin Tapio Karjalainen Vihdin 
Kameraseurasta ja Yki Hytönen Helsingistä.

Kokouksen jälkeen katselimme Seuracu-
pin kuvasatoa ja viikonlopun päätti valoku-
vaaja Timo Ripatin luento ”valokuvauksen 
tuulet”, jossa kuljettiin valokuvauksen polku 
ensimmäisestä säilyneestä valokuvasta tähän 
päivään. Mikäli siis haluat nähdä paljon hie-
noja valokuvia, luoda kontakteja, vaikuttaa 
päätöksentekoon tai vaan pitää hauskaa hy-
vässä seurassa, niin suosittelen vuosi- ja/tai 
teemanäyttelyiden avajaisiin osallistumista.

Teemanäyttelyn avajaiset ja liiton syyskokous
MARKO SEPPÄLÄTEEMU LAULAJAINEN
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NILS NYMAN

K U V A N  R E U N A - A L U E I D E N  H Ä I V Y T Y S

Avaa kuva ja valitse siitä haluamasi 
pääkohde valintatyökalulla.  Avaa  Rec-
tangular Marquee Tool => Elliptical 
Marquee Tool. Tällä työkalulla tehdään 
soikea valinta. Pehmennetään valinnan 
reunoja  valitsemalla Refine Edge ja 
sieltä säädetään liukusäätimellä Feather 
arvoon  250 px. Valintasi reunat on nyt 
häivytetty/pehmennetty  125 px  valin-
tarajan molemmin puolin.
Kuva 1_2.

Nyt valitaan tausta jolle kohde sijoite-
taan. Tausta voi olla mikä tahansa mut-
ta tässä valitaan puhdas paperi.Valitse 
File=>New=International Paper =>A5 
(tai joku muu haluttu koko). Voimme 
värjätä taustan halutuksi Paint Bucket  
(maalipytty) työkalulla. Avaa värivalin-
tataulu (etuala/tausta) ja klikkaa siinä 
valitsemaasi väriä  aktivoi se ja klikkaa 
OK. Valitse Paint Bucket ja klikkaa sillä 
uutta taustaa joka nyt muuttuu valitse-

masi väriseksi. Aktivoi valitsemasi kuva-
kohde ja kopio se,  Edit=>Copy, aktivoi 
uusi taustakuva ja valitse Edit=>Paste. 
Valitsemasi kohde on nyt reunoiltaan 
häivytettynä uudella taustalla.
Kuva 2_1.

Toinen tapa  

Valitse kuvasta pääkohde Ellep-
tical Marquee Tool työkalul-

Kuva 1._2. Kuva 1_3

Monesti näkee kuvia joissa  reuna-alueet  on sumennettu tai 
häivytetty esimerkiksi postikorteissa ja hääkuvissa  kun halutaan 

korostaa itse pääkohdetta taustan ollessa toisarvoinen  tai 
jopa sijoittaa kohde uudelle taustalle. Niinkuin kuvakäsittelyssä 

yleensäkin on useita tapoja toteuttaa haluttu lopputulos  
seuraavassa  esitetään  kolme erilaista tapaa aikaansaada  

häivytys.

la. Klikkaa pikamaski kuvan 
päälle. Käännä valinta ulkopuoli-
seksi Image=>Adjustment=>Invert. 
Lisää voimakas sumen-
nus Filter=>Blur=>Gaussian 
Blur=>liukusäätimellä 200-250. Lisää 
kohinaa Filter=>Noise=>Add  Noi-

se  arvoon 20-30. Tämä vähentää vä-
riporrastusta. Klikkaa pikamaski pois. 
Lisää taso Layer=>New=> Layer. Värjää 
taso halutulla värillä Paint Bucket työ-
kalulla. Yhdistä tasot Layer=>Flatten 
Image. Poista valinta Select=>Deselect. 

Kuva on valmis.

Kuvat 1_2, 2_2, 3_2 
ja 4_2

Kolmas tapa

Valitse kuva ja li-
sää sille taso 
Layer=>New=>Layer. 
Aseta etualan väriksi 
valkoinen. Valitse liu-
kuväri Gardient Tool 
ja sille yläpalkista va-
litse Foreground to 
Transparent  (etualan 
väristä läpinäkyväksi). 
Nyt vedä työkalulla 
kuvan nurkista koh-
ti kohteen keskustaa 
– tarvittaessa myös 
sivuilta. Kuva sumen-
tuu voimistuen kes-
kustasta kohti nurk-
kia.  Jos sumennus 
meni liian pitkälle 
lisää kuvan päälle ta-
somaski ( Photoshop 
ja Elements 10 ) Add 

a Mask. Voit maalata mustalla pensselillä 
liian pitkälle mennyttä sumennusta jol-
loin kuva paljastuu sumennuksen alta. 
Kuva on valmis.

Kuva 1_3  ja 2_3.

Kuva  2_1. Kuva 2_2.

Kuva 2_3. 

Kuva 3_2- Kuva 4_2. 
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ta valkoista paperia ja ohut-
kärkinen musta kynä. Kirjoita 
nimikirjoituksesi paperille. Ku-
vaa tai skannaa nimikirjoituk-

sesi. Avaa kuva kuvankäsittelyohjelmassa ja 
säädä siellä Levels säädöllä niin että paperi 
on mahdollisimman valkoinen ja nimesi 
mahdollisimman musta. Siirrä musta liuku-
säädin oikealle ja valkoinen vasemmalle että 
kuva on todella musta-valkoinen. Rajaa nyt 
nimikuvasi mahdollisimman tiukasti. Koska 
jatkossa käytetään Brush-työkalua tarkista 
että nimikuvasi ei ole leveämpi kuin 2500 pi-
xeliä. Seuraavaksi valitse Edit=>Define Brush 
Elementsissä tai Define Brush Preset Phosho-
pissa ja nimeä kuvasi esim. ”Nimikirjoitus”. 
Nyt nimikirjoituksesi on tallennettu Brush-

työkalun yhdeksi vaihtoehdoksi käytettäväksi 
aina milloin tarvitset. 

vaa kuva jonka haluat signee-
rata, lisää sen päälle uusi taso 
Layer=>New=>Layer. Aktivoi 
Brush-työkalu ja valitse Brush 

Preset-valikosta ”Nimikirjoitus”-vaihtoehto. 
Nyt voit valita nimikirjoituksesi värin värin-
valintataulusta. Määriteltyäsi värin klikkaa 

Brush-työkalulla kuvaasi ja nimikirjoituk-
sesi ilmestyy kuvaan. Valitse Elementsissä 
Image=>Transform=>Free Transform tai 
Photoshopissa Edit=>Free Transform jolla 
voit skaalata ja kääntää nimikirjoitustasi 
haluamaasi asentoon. Siirtotyökalulla voit 
asemoida nimikirjoituksesi haluamaasi paik-
kaan. Yhdistä tasot =>Flatten Image. 

Taiteilija signeeraa taulunsa yleensä 
omalla nimellän. Niin voit myös sinä 
tehdä omille kuvillesi. Voit tehdä sen 

kuvankäsittelyohjelmalla leimasimella – et 
tarvitse siihen erikseen kynää.

NILS NYMAN
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Opiskele sosiaalisen median asiantuntijaksi!
EduTV.fi on suomenkielinen opetusvideokirjasto, jossa voit opiskella 
omaan tahtiisi Facebookin ja Twitterin sekä pian myös digitaalisen tarinan-
kerronnan asiantuntijaksi tai harjoitella ATK-ajokorttia varten. Lisäksi 
tarjolla on laaja ja jatkuvasti kasvava opetusvideokirjasto lukuisista eri 
ohjelmista ja palveluista, kuten

 • Ms Office 2010 – Word, Excel, Powerpoint

 • Windows 7

 • Photoshop CS6

 • InDesign CS6

 • GoogleDocs

 • Mac OS X

 • iPad ja iOS

 • ja paljon muuta

Palvelun tärkeimmät ominaisuudet
Voit opiskella silloin kun sinulle sopii. Missä ja milloin tahansa. Tietokoneella, 
tablet-laitteella tai vaikka puhelimellasi. Kurssit on jaoteltu ja otsikoitu pie-
niin osiin, joita voit katsoa vaikka työmatkalla. Kaiken lisäksi EduTV.fi 
muistaa jo katsomasi osiot. EduTV.fi -palvelun käyttäjät voivat myös tulostaa 
todistuksen katsomistaan kursseista. Kaikki palvelun kurssit ovat sinulle aina 
tarjolla ja opetuskirjasto kasvaa viikoittain.

Etuja opetusvideokirjaston käytöstä?
 • Tehosta omaa ajankäyttöäsi
 • Opit uusia taitoja helposti
 • Syvennä osaamisesi tasoa
 • Saat käyttöösi tukipalvelun
 • Helppo tapa opiskella - missä vaan
 • Ja opiskele omaan tahtiisi
 • Saat itsellesi kurssitodistukset

EduTV.� edullisesti sinulle - vai koko organisaatiolle?
Voit ostaa itsellesi kuukauden käyttöajan (25,- sis. alv.) ja saat käyttöösi 
koko opetuskirjaston.

•   Voit myös ostaa palvelun käyttöösi määräajaksi tai koko vuodeksi

•   Palvelu käyttöön joko vain itsellesi, tiimillesi tai koko organisaatiollesi.

• Saatavilla myös määrälisenssejä koulullesi ja koko kampuksen lisenssejä.

Tutustu EduTV.-� -palvelun etusivulla oleviin videoesimerkkeihin ja ota yhteyttä, 
teemme tarjouksen opetuskirjastosta teidän tarpeeseenne.


